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Read Me First

Notes on Online Manual Usage
How to Print

Notes on Online Manual Usage

• Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

• In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

• Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

• In principle, the descriptions in this guide are based on the product at the time of its initial sale.
• This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied

with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

Note
• In Windows 8, print in the desktop version.

• In Internet Explorer 9 or 10

1. Select  (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

• In Internet Explorer 8

1. Press the Alt key to display the menus.
Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.

2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

• In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.
3. Select the Print Background (colors & images) checkbox in Format & Options.
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How to Use the Online Manual

Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

Note
Instructions including notes for operation and additional explanations.

Basic

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,

registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under

license.
• Google Cloud Print, Google Chrome, Android, Google Play and Picasa are either registered trademarks

or trademarks of Google Inc.
• Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either

registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

• Photo Rag is a trademark of Hahnemühle FineArt GmbH.
• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.
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Enter keywords in the search window and click  (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper", "(your product's model name) 1000"

Search Tips

You can search for target pages by entering keywords in the search window.

Note
• The displayed screen may vary.

• Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about

Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search

• Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search
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Note
• The displayed screen varies depending on your product.

• Searching for Application Functions

Enter your application's name and a keyword for the function you want to learn about

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

• Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page
Refer to "Color Settings Tab" for your model from Home of the Online Manual for details. 
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Notes on Operation Explanations

In this guide, most of the operations are described based on the windows displayed when Windows 8
operating system (called Windows 8 below) is used.
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Useful Functions Available on the Printer

The following useful functions are available on the printer.
Enjoy pleasant photography experience by utilizing various functions.

Useful Functions Available from Applications and the Main Unit

You can create items such as collages easily or download delightful
printing materials, and print them.
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Useful Functions Available from Applications and the Main Unit

On the printer, the following useful functions are available from applications and the main unit.

• Print Photos Easily
• Download Content Materials
• Print Photos on Facebook

Print Photos Easily Using an Application

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

<People View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in
slide shows.
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If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.

Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

Other Various Functions

My Image Garden has many other useful functions.

Refer to "What You Can Do with My Image Garden" for details.

Download a Variety of Content Materials

CREATIVE PARK

A "printing materials site" where you can download all the printing materials for free.
Various types of content such as seasonal cards and paper crafts that can be made by assembling

16



paper parts are provided.
It is easily accessible from Quick Menu.

CREATIVE PARK PREMIUM

A service where customers using models that support PREMIUM Contents can download exclusive
printing materials.
PREMIUM Contents can be downloaded easily via My Image Garden. Downloaded PREMIUM
Contents can be printed directly with My Image Garden.
To download PREMIUM Contents, make sure that genuine Canon ink tanks/ink cartridges are installed
for all colors on a supported printer.

Note
• The designs of PREMIUM Contents provided in this page are subject to change without prior

notice.

Print Photos on Facebook Easily Using a Facebook App "Print Your Days"

Use Print Your Days to collect Facebook photos of memories of parties and travel, recent activity of your
family and friends, your hobbies, etc., then create and print a work of art.
Print Your Days is available from the Print Your Days Facebook page.
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Overview of the Printer

Safety Guide
Safety Precautions
Regulatory and Safety Information

Main Components and Basic Operations
Main Components
About the Power Supply of the Printer

Loading Paper
Loading Paper

Replacing a FINE Cartridge
Replacing a FINE Cartridge
Checking the Ink Status from Your Computer

Maintenance
When Printing Becomes Faint or Colors Are Incorrect
Performing Maintenance from a Computer
Cleaning the Printer

Changing the Printer Settings
Changing Printer Settings from Your Computer

Tips for Ensuring Optimal Printing Quality
Useful Information about Ink
Key Points to Successful Printing
Be Sure to Make Paper Settings after Loading Paper
Storing Printed Images
Printer Handling Precautions
Key to Enjoying Consistent Printing Quality
Precautions for Safe Transport of the Printer

Legal Limitations on Use of Your Product and Use of Images

Specifications
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Safety Guide

Safety Precautions

Regulatory and Safety Information
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Safety Precautions

Choosing a location

• Do not install the machine in a location that is unstable or subject to excessive vibration.
• Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or

close to a heating source.
To avoid the risk of fire or electric shocks, use the machine under the operating environment specified
in the Specification.

• Do not place the machine on a thick rug or carpet.
• Do not place the machine with its back attached to the wall.

Power supply

• Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

• Never remove the plug by pulling on the cord.
Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

• Do not use an extension lead/cord.

Working around the machine

• Never put your hands or fingers in the machine while it is printing.
• When moving the machine, carry the machine at both ends. In case the machine weighs more than

14 kg, it is recommended to have two people lifting the machine. Accidental dropping of the machine
causes injury. For the machine's weight, refer to the Specification.

• Do not place any object on the machine. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the machine.

• Do not transport or use the machine on a slant, vertically or upside-down, as the ink may leak and
damage the machine.

Working around the machine (For the multifunction printer)

• When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The
Platen Glass may break and cause injury.

Print Heads/ink tanks and FINE Cartridges

• Keep ink tanks out of the reach of children. In case ink* is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.
* Clear Ink contains nitrate salts (For models containing Clear Ink).

• In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

• Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.
The metal parts may be very hot and could cause burns.

• Do not throw ink tanks and FINE Cartridges into fire.
• Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
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Regulatory and Safety Information

For models containing lithium battery

• Dispose of used batteries according to the local regulations.
• Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10399

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A., Inc.
One Canon Park
Melville, New York 11747
1-800-652-2666

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human
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health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.

Korisnici u Srbiji

Ovaj simbol označava da ovaj proizvod ne sme da se odlaže sa ostalim kućnim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati određenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sličan novi proizvod, ili ovlašćenom centru
za prikupljanje za reciklažu istrošene električne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada može da ima moguće negativne posledice po životnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavnom vezuju za EEE. U isto vreme, vaša saradnja na
ispravnom odlaganju ovog proizvoda će doprineti efikasnom korišćenju prirodnih resursa. Za više
informacija o tome gde možete da predate vašu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne službe, odobreni plan reciklaže ili Gradsku čistoću. Za više
informacija o vraćanju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce your electricity costs. After the last print it switches to
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a time,
the device switches to its Power Save Mode. The devices consume less power (Watt) in these modes.
If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode,
please consider that this device may then only switch to a lower energy level after a longer period of
time or not at all.
Canon does not recommend extending the Activation Times from the optimum ones set as default.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.
Products which meet the stringent requirements of the Energy Star® programme for both environmental
benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can
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support printing on media down to a weight of 64g/m2, lighter paper means less resources used and a
lower environmental footprint for your printing needs.
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Main Components and Basic Operations

Main Components

About the Power Supply of the Printer
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Main Components

Front View

Rear View

Inside View
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Front View

(1) paper support
Open to load paper in the rear tray.

(2) paper guide
Align with the left side of the paper stack.

(3) rear tray
Load paper here. Two or more sheets of the same size and type of paper can be loaded at the same
time, and fed automatically one sheet at a time.

Loading Plain Paper / Photo Paper
Loading Envelopes

(4) cover
Open to replace the FINE cartridge or remove jammed paper inside the printer.

(5) paper output tray
Printed paper is ejected. Pull out it before printing.

(6) output tray extension
Extend to support ejected paper. Extend it when printing.
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* All lamps are shown lit in the above figure for explanatory purposes.

(7) ON/RESUME button
Press to turn the power on or off. You can cancel a print job in progress. You can also press this button
to release from printer error status or to select a maintenance function.

(8) POWER lamp
This lamp lights green after flashing when the power is turned on.

Note
• You can check the status of the printer by the POWER and Alarm lamps.

• POWER lamp is off: The power is off.
• POWER lamp lights green: The printer is ready to print.
• POWER lamp flashes green: The printer is getting ready to print, or printing is in progress.
• Alarm lamp flashes orange: An error has occurred and the printer is not ready to print.
• POWER lamp flashes green and Alarm lamp flashes orange alternately: An error that requires

contacting the service center may have occurred.

If an Error Occurs

(9) Alarm lamp
This lamp lights or flashes orange when an error occurs.
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Rear View

(1) power cord connector
Plug in the supplied power cord.

(2) USB port
Plug in the USB cable to connect the printer with a computer.

Important
• Do not touch the metal casing.
• Do not plug in or unplug the USB cable while printing.
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Inside View

(1) FINE cartridge (ink cartridges)
A replaceable cartridge that integrates print head and ink tank.

(2) FINE cartridge holder
Install the FINE cartridge.

The color FINE cartridge should be installed into the left slot and the black FINE cartridge should be
installed into the right slot.

Note
• For details on replacing a FINE cartridge, see Replacing a FINE Cartridge.

Important
• The area around the parts (A) may be splattered with ink. This does not affect the performance of the

printer.
• Do not touch the parts (A). The printer may not print properly if you touch them.

29



About the Power Supply of the Printer

Confirming that the Power Is On

Turning the Printer On and Off

Notice for the Power Plug/Power Cord

Notice for Unplugging the Power Cord
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Confirming that the Power Is On

The POWER lamp is lit green when the printer is turned on.

Note
• It may take a while for the printer to start printing immediately after you turn on the printer.
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Turning the Printer On and Off

Turning on the printer

1. Press the ON/RESUME button to turn on the printer.

The POWER lamp flashes and then remains lit green.

Confirming that the Power Is On

Note
• It may take a while for the printer to start printing immediately after you turn on the printer.
• If the Alarm lamp lights up or flashes orange, see If an Error Occurs.
• You can set the printer to automatically turn on when a print operation is performed from a

computer. This feature is set to off by default.

Managing the Printer Power

Turning off the printer

Note
• When the paper jam error or paper out error has occurred, you cannot turn the printer off even if you

press the ON/RESUME button on the printer. Dismiss the error, then turn off the printer.

If an Error Occurs

1. Press the ON/RESUME button to turn off the printer.

When the POWER lamp stops flashing, the printer is turned off.
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Important
• When you unplug the power cord after turning off the printer, be sure to confirm that the

POWER lamp is off.

Note
• You can set the printer to automatically turn off when no print jobs are sent to the printer for a

certain interval. This is the default setting.

Managing the Printer Power
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Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not have anything
unusual described below.

• The power plug/power cord is hot.
• The power plug/power cord is rusty.
• The power plug/power cord is bent.
• The power plug/power cord is worn.
• The power plug/power cord is split.

Caution
• If you find anything unusual with the power plug/power cord described above, unplug the power cord

and call for service. Using the printer with one of the unusual conditions above may cause a fire or an
electric shock.
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Notice for Unplugging the Power Cord

To unplug the power cord, follow the procedure below.

Important
• When you unplug the power cord, press the ON/RESUME button, then confirm that the POWER lamp is

off. Unplugging the power cord while the POWER lamp is lit or flashing may cause drying or clogging of
the print head and print quality may be reduced.

1. Press the ON/RESUME button to turn the printer off.

Note
• When the paper jam error or paper out error has occurred, you cannot turn the printer off even if

you press the ON/RESUME button on the printer. Dismiss the error, then turn off the printer.

If an Error Occurs

2. Confirm that the POWER lamp is off.

3. Unplug the power cord.

The specification of the power cord differs depending on the country or region of use.
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Loading Paper

Loading Paper
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Loading Paper

Loading Plain Paper / Photo Paper

Loading Envelopes

Media Types You Can Use

Media Types You Cannot Use

Printing Area
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Loading Plain Paper / Photo Paper

You can load plain paper or photo paper.

Important
• If you cut plain paper into small size such as 4" x 6" (10 x 15 cm) or 5" x 7" (13 x 18 cm) to perform trial

print, it can cause paper jams.

Note
• We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use.

• You can use general copy paper.

For the page size and paper weight you can use for this printer, see Media Types You Can Use.

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

Note
• Align the edges of paper neatly before loading. Loading paper without aligning the edges may

cause paper jams.
• If paper is curled, hold the curled corners and gently bend them in the opposite direction until the

paper becomes completely flat.

For details on how to flatten curled paper, see "Load the paper after correcting its curl." in Paper Is
Smudged/Printed Surface Is Scratched.

2. Load paper.

1. Open the paper support.

2. Pull out the paper output tray and the output tray extension.
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3. Slide the paper guide (A) to the left, and load the paper against the far right of the rear tray
WITH THE PRINT SIDE FACING YOU.

4. Slide the paper guide (A) to align it with the paper stack.

Do not slide the paper guide too hard against the paper. The paper may not be fed properly.

Important
• Always load paper in the portrait orientation (B). Loading paper in the landscape orientation (C) can

cause paper jams.
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Note
• Do not load sheets of paper higher than the load limit mark (D).

Note
• The printer may make operating noise when feeding paper.
• After loading paper, select the size and type of the loaded paper on the print settings screen of the

printer driver.
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Loading Envelopes

You can load Envelope DL and Envelope Com 10.

The address is automatically rotated and printed according to the envelope's direction by specifying with the
printer driver properly.

Important
• Do not use the following envelopes. They could jam in the printer or cause the printer to malfunction.

• Envelopes with an embossed or treated surface
• Envelopes with a double flap
• Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

• Press down on all four corners and edges of the envelopes to flatten them.

• If the envelopes are curled, hold the opposite corners and gently twist them in the opposite
direction.

• If the corner of the envelope flap is folded, flatten it.
• Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

The figures above show a side view of the leading edge of the envelope.

Important
• The envelopes may jam in the printer if they are not flat or the edges are not aligned. Make sure

that no curl or puff exceeds 0.1 inch (3 mm).

2. Load envelopes.

1. Open the paper support.

2. Pull out the paper output tray and the output tray extension.
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3. Slide the paper guide (A) to the left, and load the envelopes against the far right of the rear
tray WITH THE PRINT SIDE FACING YOU.

The folded flap of the envelope will be faced up on the left side.

Up to 5 envelopes can be loaded at once.

4. Slide the paper guide (A) to align it with the envelopes.

Do not slide the paper guide too hard against the envelopes. The envelopes may not be fed properly.

(B) Rear side
(C) Address side

Note
• Do not load sheets of paper higher than the load limit mark (D).
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Note
• The printer may make operating noise when feeding paper.
• After loading envelopes, select the size and type of the loaded envelopes on the print settings screen of

the printer driver.
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Media Types You Can Use

Use plain paper for printing texts or photo paper for printing photos, for the best print results. We
recommend the use of Canon genuine paper for printing your important photos.

Media Types

Commercially available papers

• Plain Paper (including recycled paper)*1
• Envelopes

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction manual
supplied with the paper for detailed information on the printable side and notes on handling paper. For
information on the page sizes available for each Canon genuine paper, access our website.

Note
• You may not be able to purchase some Canon genuine papers depending on the country or region

of purchase. Paper is not sold in the US by Model Number. Purchase paper by name.

Paper for printing photos:

• Glossy Photo Paper "Everyday Use" <GP-501/GP-601>
• Photo Paper Glossy <GP-601>
• Photo Paper Plus Glossy II <PP-201>

*1 100% recycled paper can be used.

Paper Load Limit
Setting the Media Type with the Printer Driver

Page Sizes

You can use the following page sizes.

Standard sizes:

• Letter
• Legal
• A5
• A4
• B5
• 4" x 6" (10 x 15 cm)
• 5" x 7" (13 x 18 cm)
• Envelope DL
• Envelope Com 10

Non-standard sizes:

You can print on non-standard size paper within the following ranges.

• Minimum size: 4.00 x 6.00 inches (101.6 x 152.4 mm)
• Maximum size: 8.50 x 26.61 inches (215.9 x 676.0 mm)

44



Paper Weight

You can use paper in the following weight range.

• 17 to 28 lb (64 to 105 g /m2) (except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the printer.

Notes on Storing Paper

• Take out only the necessary number of paper from the package, just before printing.
• To avoid curling, when you do not print, put unused paper back into the package and keep it on a

level surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Paper Load Limit

Commercially Available Papers

Media Name Rear Tray Paper Output Tray

Plain Paper (including recycled paper) Approx. 60 sheets

(10 sheets: Legal)

Approx. 10 sheets

Envelopes 5 envelopes *1

Canon Genuine Papers

Note
• We recommend that you remove the previously printed sheet from the paper output tray before

continuously printing to avoid blurs and discoloration.

Paper for printing photos:

Media Name <Model No.> Rear Tray

Glossy Photo Paper "Everyday Use" <GP-501/GP-601>*2 20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Glossy <GP-601>*2 20 sheets: 4" x 6" (10 x 15 cm)

Photo Paper Plus Glossy II <PP-201>*2 10 sheets: 5" x 7" (13 x 18 cm)

20 sheets: 4" x 6" (10 x 15 cm)

*1 We recommend that you remove the previously printed envelope from the paper output tray before
continuously printing to avoid blurs and discoloration.
*2 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed
properly. In this case, load one sheet at a time.
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Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but also
the printer to jam or malfunction.

• Folded, curled, or wrinkled paper
• Damp paper
• Paper that is too thin (weighing less than 17 lb (64 g /m2))
• Paper that is too thick (weighing more than 28 lb (105 g /m2), except for Canon genuine paper)
• Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when printing

on paper smaller than A5)
• Picture postcards
• Postcards
• Envelopes with a double flap
• Envelopes with an embossed or treated surface
• Envelopes whose gummed flaps are already moistened and adhesive
• Any type of paper with holes
• Paper that is not rectangular
• Paper bound with staples or glue
• Paper with adhesives
• Paper decorated with glitter, etc.
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Printing Area

Printing Area

Other Sizes than Letter, Legal, Envelopes

Letter, Legal

Envelopes
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Printing Area

To ensure the best print quality, the printer allows a margin along each edge of media. The actual printable
area will be the area inside these margins.

Recommended printing area  : Canon recommends that you print within this area.

Printable area  : The area where it is possible to print. However, printing in this area can affect the print
quality or the paper feed precision.

49



Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)

A5 5.56 x 7.49 inches (141.2 x 190.3 mm)

A4 8.00 x 10.92 inches (203.2 x 277.3 mm)

B5 6.90 x 9.34 inches (175.2 x 237.3 mm)

4" x 6" (10 x 15 cm) 3.73 x 5.22 inches (94.8 x 132.7 mm)

5" x 7" (13 x 18 cm) 4.73 x 6.22 inches (120.2 x 158.1 mm)

 Recommended printing area

(A) 1.24 inches (31.6 mm)
(B) 1.15 inches (29.2 mm)

 Printable area

(C) 0.12 inch (3.0 mm)
(D) 0.66 inch (16.7 mm)
(E) 0.13 inch (3.4 mm)
(F) 0.13 inch (3.4 mm)
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Letter, Legal

Size Printable Area (width x height)

Letter 8.00 x 10.22 inches (203.2 x 259.7 mm)

Legal 8.00 x 13.22 inches (203.2 x 335.9 mm)

 Recommended printing area

(A) 1.24 inches (31.6 mm)
(B) 1.15 inches (29.2 mm)

 Printable area

(C) 0.12 inch (3.0 mm)
(D) 0.66 inch (16.7 mm)
(E) 0.25 inch (6.4 mm)
(F) 0.25 inch (6.3 mm)
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Envelopes

Size Recommended Printing Area (width x height)

Envelope DL 3.88 x 7.06 inches (98.8 x 179.5 mm)

Envelope Com 10 3.68 x 7.90 inches (93.5 x 200.8 mm)

 Recommended printing area

(A) 0.31 inch (8.0 mm)
(B) 1.28 inches (32.5 mm)
(C) 0.22 inch (5.6 mm)
(D) 0.22 inch (5.6 mm)
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Replacing a FINE Cartridge

Replacing a FINE Cartridge

Checking the Ink Status from Your Computer
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Replacing a FINE Cartridge

When remaining ink cautions or errors occur, the Alarm lamp will flash orange to inform you of the error.
Count the number of flashes and take appropriate action.

If an Error Occurs

Note
• For information on the compatible FINE cartridge, refer to the printed manual: Safety and Important

Information.

Replacing Procedure

When you need to replace a FINE cartridge, follow the procedure below.

Important
• Do not touch the electrical contacts (A) or print head nozzle (B) on a FINE cartridge. The printer may

not print properly if you touch them.

• If you remove a FINE cartridge, replace it immediately. Do not leave the printer with the FINE
cartridge removed.

• Use a new FINE cartridge for replacement. Installing a used FINE cartridge may cause the nozzles to
clog.

Furthermore, with such a FINE cartridge, the printer will not be able to inform you when to replace the
FINE cartridge properly.

• Once a FINE cartridge has been installed, do not remove it from the printer and leave it out in the
open. This will cause the FINE cartridge to dry out, and the printer may not operate properly when it
is reinstalled. To maintain optimal printing quality, use a FINE cartridge within six months of first use.

Note
• If a FINE cartridge runs out of ink, you can print with either color or black FINE cartridge, in whichever

ink remains, only for a while. However the print quality may be reduced compared to when printing
with both cartridges. We recommend to use a new FINE cartridge in order to obtain optimum
qualities.

Even when printing with one ink only, print with leaving the empty FINE cartridge installed. If either of
the color FINE cartridge or black FINE cartridge is not installed, an error occurs and the printer
cannot print.

For information on how to configure this setting, see Setting the Ink Cartridge to be Used.

• Color ink may be consumed even when printing a black-and-white document or when black-and-
white printing is specified.
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Both color ink and black ink are also consumed in the standard cleaning and deep cleaning of the
print head, which may be necessary to maintain the performance of the printer. When ink runs out,
replace the FINE cartridge immediately with a new one.

Useful Information about Ink

1. Make sure that the power is turned on.

2. Retract the paper output tray and the output tray extension.

3. Open the cover.

The FINE cartridge holder moves to the replacement position.

Caution
• Do not hold the FINE cartridge holder to stop or move it forcibly. Do not touch the FINE

cartridge holder until it stops completely.

Important
• The inside of the printer may be stained with ink. Be careful not to stain your hands or clothing

when replacing the FINE cartridge. You can easily wipe off the ink from the inside of the printer
with tissue paper or the like.

For details on the cleaning, refer to Safety and Important Information.

• Do not touch the metallic parts or other parts inside the printer.
• If the cover is left open for more than 10 minutes, the FINE cartridge holder may move and the

Alarm lamp light. In this case, close the cover, then open it again.

4. Remove the empty FINE cartridge.

1. Push down the FINE cartridge until it clicks.

55



2. Remove the FINE cartridge.

Important
• Handle the FINE cartridge carefully to avoid staining of clothing or the surrounding area.
• Discard the empty FINE cartridge according to the local laws and regulations regarding disposal

of consumables.

5. Prepare a new FINE cartridge.

1. Take a new FINE cartridge out of its package and remove the protective tape (C) gently.
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Important
• If you shake a FINE cartridge, ink may spill out and stain your hands and the surrounding area.

Handle a FINE cartridge carefully.
• Be careful not to stain your hands and the surrounding area with ink on the removed protective

tape.
• Do not reattach the protective tape once you have removed it. Discard it according to the local

laws and regulations regarding disposal of consumables.
• Do not touch the electrical contacts or print head nozzle on a FINE cartridge. The printer may

not print properly if you touch them.

6. Install the FINE cartridge.

1. Insert the new FINE cartridge at a slant into the FINE cartridge holder.

The color FINE cartridge should be installed into the left slot and the black FINE cartridge should be
installed into the right slot.

Important
• Insert the FINE cartridge gently so that it does not hit the electrical contacts on the FINE cartridge

holder.
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2. Push the FINE cartridge in and up firmly until it snaps into place.

Important
• Check if the FINE cartridge is installed correctly.
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• The printer cannot print unless both the color FINE cartridge and black FINE cartridge are
installed. Be sure to install both cartridges.

7. Close the cover.

Note
• If the Alarm lamp lights or flashes orange after the cover is closed, take appropriate action.

If an Error Occurs

• The printer may make noise during operation.

8. Adjust the print head position.

After replacing the FINE cartridge, align the print head.

Aligning the Print Head Position from Your Computer
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Maintenance

When Printing Becomes Faint or Colors Are Incorrect

Performing Maintenance from a Computer

Cleaning the Printer
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When Printing Becomes Faint or Colors Are Incorrect

Maintenance Procedure

Printing the Nozzle Check Pattern

Examining the Nozzle Check Pattern

Cleaning the Print Head
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Maintenance Procedure

If print results are blurred, colors are not printed correctly, or print results are unsatisfactory (e.g. misaligned
printed ruled lines), perform the maintenance procedure below.

Important
• Do not rinse or wipe the FINE cartridge. This can cause trouble with the FINE cartridge.

Note
• Check if ink remains in the FINE cartridge.

Checking the Ink Status from Your Computer

• Check if the FINE cartridge is installed correctly.

Replacing Procedure

Also check if the protective tape on the bottom of the FINE cartridge is removed.

• If the Alarm lamp lights or flashes orange, see If an Error Occurs.
• Increasing the print quality in the printer driver settings may improve the print result.

Changing the Print Quality and Correcting Image Data

When the Print Results Are Blurred or Uneven:

Step1  Print the nozzle check pattern.

From the printer

Printing the Nozzle Check Pattern

From the computer

Use Your Computer to Print a Nozzle Check Pattern

Step2  Examine the nozzle check pattern.

If there are missing lines or horizontal white streaks in the pattern:

Step3  Clean the print head.

From the printer

Cleaning the Print Head

From the computer
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Cleaning the Print Heads from Your Computer

After cleaning the print head, print and examine the nozzle check pattern:  Step1

If the problem is not resolved after cleaning the print head twice:

Step4  Clean the print head deeply.

From the computer

Cleaning the Print Heads from Your Computer

If the problem is not resolved, turn off the power and clean the print head deeply again after 24 hours.

If the problem is still not resolved:

Step5  Replace a FINE cartridge.

Note
• If the problem is still not resolved after replacing the FINE cartridge, contact the service center.

When the Print Results Are Not Even such as the Ruled Lines Are
Misaligned:

Step  Align the print head.

From the computer

Aligning the Print Head Position from Your Computer
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzle.

Note
• If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace the FINE

cartridge whose ink is low.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the rear tray.

3. Pull out the paper output tray and the output tray extension.

4. Hold down the ON/RESUME button until the POWER lamp flashes green twice, then
release it immediately.

The nozzle check pattern will be printed.

Do not perform any other operations until the printer completes the printing of the nozzle check pattern.

5. Examine the nozzle check pattern.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in the pattern (A) or horizontal white streaks in the pattern
(B).

(C) Number of sheets printed so far

If there are missing lines in the pattern (A):

Cleaning the print head is required.

(D) Good
(E) Bad (lines are missing)

If there are horizontal white streaks in the pattern (B):

Cleaning the print head is required.

(F) Good
(G) Bad (horizontal white streaks are present)

Note
• The total number of sheets printed so far is shown in increments of 50 sheets on the printout of the

nozzle check pattern.
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

1. Make sure that the power is turned on.

2. Hold down the ON/RESUME button until the POWER lamp flashes green once, then
release it immediately.

The printer starts cleaning the print head.

The cleaning will be complete when the POWER lamp lights green after flashing.

Do not perform any other operations until the printer completes the cleaning of the print head. This takes
about 30 seconds.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

Note
• If the problem is not resolved after cleaning the print head twice, clean the print head deeply.

Cleaning the Print Heads from Your Computer
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Performing Maintenance from a Computer

Cleaning the Print Heads from Your Computer
Cleaning the Paper Feed Rollers from Your Computer
Aligning the Print Head Position from Your Computer
Use Your Computer to Print a Nozzle Check Pattern
Cleaning Inside the Printer
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Cleaning the Print Heads from Your Computer

The print head cleaning function allows you to clear up clogged print head nozzle. Perform print head
cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print head is as follows:

 Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the ink group for which cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing cleaning.

3. Execute cleaning

Make sure that the printer is on and then click Execute.

Print head cleaning starts.

4. Complete cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

Important
• Cleaning consumes a small amount of ink.

Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

 Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem.

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab
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When the Deep Cleaning dialog box opens, select the ink group for which deep cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

Print head deep cleaning starts.

4. Complete deep cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

Important
• Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

Note
• If there is no sign of improvement after Deep Cleaning, switch off the printer, wait 24 hours, and then

perform Deep Cleaning again. If there is still no sign of improvement, see "Ink Is Not Ejected."

Related Topic

Use Your Computer to Print a Nozzle Check Pattern
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Cleaning the Paper Feed Rollers from Your Computer

Cleans the paper feed rollers. Perform feed roller cleaning when there are paper particles sticking to the
paper feed rollers and paper is not fed properly.

The procedure for performing the feed roller cleaning is as follows:

 Roller Cleaning

1. Prepare the printer

Remove all sheets of paper from the rear tray.

2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab

The confirmation message appears.

4. Execute paper feed roller cleaning

Make sure that the printer is on and then click OK.
Paper feed roller cleaning starts.

5. Complete paper feed roller cleaning

After the rollers have stopped, follow the message instructions and load one sheet of plain paper or a
cleaning sheet available on the market into the rear tray. Then click OK.

Paper will be ejected and feed roller cleaning will be completed.
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Aligning the Print Head Position from Your Computer

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

The procedure for performing print head alignment is as follows:

Note
• If you are adjusting the head position while the software is being installed from the Setup CD-ROM,

start from Step 3.

 Print Head Alignment

1. Open the printer driver setup window

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the printer

Load three sheets of A4 size or Letter size plain paper into the rear tray.

4. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

5. Check the printed pattern

Enter the numbers of the patterns with the least amount of streaks in the associated boxes.
Even if the patterns with the least amount of streaks are clicked in the preview window, their numbers
are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

Note
• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical

streaks.

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal streaks.

(A) Least noticeable horizontal streaks
(B) Most noticeable horizontal streaks

6. Confirm the displayed message and click OK

The second pattern is printed.

7. Check the printed pattern

Enter the numbers of the patterns with the least noticeable horizontal stripes in the associated boxes.
Even if the patterns with the least noticeable horizontal stripes are clicked in the preview window, their
numbers are automatically entered in the associated boxes.

When you have entered all the necessary values, click OK.

Note
• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical

streaks.
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(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

8. Confirm the displayed message and click OK

The third pattern is printed.

9. Check the printed pattern

Enter the numbers of the patterns with the least noticeable horizontal stripes in the associated boxes.
Even if the patterns with the least noticeable horizontal stripes are clicked in the preview window, their
numbers are automatically entered in the associated boxes.

When you have entered all the necessary values, click OK.

Note
• If it is difficult to pick the best pattern, pick the setting that produces the least noticeable

horizontal stripes.

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

Note
• To print and check the current setting, open the Start Print Head Alignment dialog box, and click

Print Alignment Value.

73



Use Your Computer to Print a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

 Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing the nozzle check
pattern.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the rear tray.

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. When the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.

Related Topic

Cleaning the Print Heads from Your Computer
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Cleaning Inside the Printer

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on the back side of
the paper.
Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on the
printed page.

The procedure for performing bottom plate cleaning is as follows:

 Bottom Plate Cleaning

1. Open the printer driver setup window

2. Click Bottom Plate Cleaning on the Maintenance tab

The Bottom Plate Cleaning dialog box opens.

3. Load paper in the printer

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then
unfold the sheet.
Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down.

4. Perform the bottom plate cleaning

Make sure that the printer is on and then click Execute.
Bottom plate cleaning starts.
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Cleaning the Printer

Cleaning the Exterior of the Printer

Cleaning the Paper Feed Roller

Cleaning the Inside of the Printer (Bottom Plate Cleaning)
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Cleaning the Exterior of the Printer

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.
Smooth out wrinkles on the cloth if necessary before cleaning.

Important
• Be sure to turn off the power and unplug the power cord before cleaning the printer.
• Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not

to scratch the surface.
• Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean

the printer, as this may cause a malfunction or damage the surface of the printer.
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Cleaning the Paper Feed Roller

If the paper feed rollers are dirty or paper powder is attached to it, paper may not be fed properly.

In this case, clean the paper feed rollers from the computer. Cleaning will wear out the paper feed rollers, so
perform this only when necessary.

Cleaning the Paper Feed Rollers from Your Computer

If the problem is not resolved after cleaning the paper feed rollers from the computer, turn off the power,
unplug the power cord, then wipe the paper feed rollers (the center roller and the right roller) (A) located
inside the rear tray with a moistened cotton swab or the like while rotating them manually. Do not touch the
rollers with your fingers. Rotate the rollers two or more times.

After cleaning the paper feed rollers, turn on the power, then clean the paper feed rollers again.

If the problem is not resolved after cleaning the paper feed rollers, contact the service center.
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Cleaning the Inside of the Printer (Bottom Plate Cleaning)

Remove stains from the inside of the printer. If the inside of the printer becomes dirty, printed paper may get
dirty, so we recommend performing cleaning regularly.

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on and remove any paper from the rear tray.

2. Prepare paper.

1. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the paper.

2. Load only this sheet of paper in the rear tray with the open side facing you.

3. Pull out the paper output tray and the output tray extension.

3. Hold down the ON/RESUME button until the POWER lamp flashes green five times, then
release it immediately.

The paper cleans the inside of the printer as it feeds through the printer.

Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning
again.

Note
• When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.

If the problem is not resolved after performing cleaning again, the protrusions inside the printer may be
stained. Wipe off any ink from the protrusions using a cotton swab or the like.
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Important
• Be sure to turn off the power and unplug the power cord before cleaning the printer.
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Changing the Printer Settings

Changing Printer Settings from Your Computer
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Changing Printer Settings from Your Computer

Changing the Print Options

Registering a Frequently Used Printing Profile

Setting the Ink Cartridge to be Used

Managing the Printer Power

Reducing the Printer Noise

Changing the Printer Operation Mode
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Specify this option if you encounter print failures such as part of an image data being cut off.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab

The Print Options dialog box opens.

Note
• When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings

If necessary, change the setting of each item, and then click OK.

The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.
Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:

Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if
necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...

The Save Commonly Used Settings dialog box opens.

4. Save the settings

Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.
In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the
Quick Setup tab.
The name and icon are displayed in Commonly Used Settings.

84



Important
• To save the page size, orientation, and number of copies that was set in each sheet, click Options...,

and check each item.

Note
• When you re-install the printer driver or upgrade the printer driver version, the print settings that are

already registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register the print
settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.
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Setting the Ink Cartridge to be Used

This feature enables you to specify the most appropriate FINE cartridge among installed cartridges
according to an intended use.
When one of the FINE cartridges becomes empty and cannot be replaced immediately by a new one, you
can specify the other FINE cartridge that still has ink and continue printing.

The procedure for specifying the FINE cartridge is as follows:

 Ink Cartridge Settings

1. Open the printer driver setup window

2. Click Ink Cartridge Settings on the Maintenance tab

The Ink Cartridge Settings dialog box appears.

3. Select the FINE cartridge to be used

Select the FINE cartridge to be used for printing and click OK.
The specified FINE cartridge will be used from the next printing.

Important
• When a setting other than Plain Paper or Envelope is selected for Media Type on the Main tab,

Black Only is disabled because the printer uses the color FINE cartridge to print documents.
• Do not detach the FINE cartridge that is not in use. Printing cannot be performed while either FINE

cartridge is detached.
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Managing the Printer Power

This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

 Power Off

The Power Off function turns off the printer. When you use this function, you will not be able to turn the
printer on from the printer driver.

1. Open the printer driver setup window

2. Execute power off

Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.

 Auto Power

Auto Power allows you to set Auto Power On and Auto Power Off.

The Auto Power On function automatically turns on the printer when data is received.
The Auto Power Off function automatically turns off the printer when there are no operations from the
printer driver or the printer for a specified period of time.

1. Open the printer driver setup window

2. Make sure that the printer is on and then click Auto Power on the Maintenance tab

The Auto Power Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Auto Power On
Specifying Enable from the list will turn the printer on upon receipt of print data.

Auto Power Off
Specify the time from the list. When this time lapses without any operations from the printer driver
or the printer, the printer is turned off automatically.

4. Apply the settings
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Click OK. When the confirmation message appears, click OK.
The Maintenance tab is displayed again.

The setting is enabled after this. When you want to disable this function, select Disable from the list
according to the same procedure.

Note
• When the printer is turned off, the Canon IJ Status Monitor message varies depending on the Auto

Power On setting.
When the setting is Enable, "Printer is standing by" is displayed. When the setting is Disable,
"Printer is offline" is displayed.
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Reducing the Printer Noise

The silent function allows you to reduce the operating noise of this printer. Select when you wish to reduce
the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

 Quiet Settings

1. Open the printer driver setup window

2. Click Quiet Settings on the Maintenance tab

The Quiet Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified
period of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to
the same time, the quiet mode will not function.

Important
• You can set the quiet mode from the printer or the printer driver.

No matter how you use to set the quiet mode, the mode is applied when you perform
operations from the printer or printing from the computer.

• If you specify a time for Use quiet mode during specified hours, quiet mode is not applied
to operations (direct print, etc.) performed directly from the printer.

4. Apply the settings

Make sure that the printer is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.
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Note
• The effects of the quiet mode may be less depending on the print quality settings.
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Changing the Printer Operation Mode

If necessary, switch between various modes of printer operation.

The procedure for configuring Custom Settings is as follows:

 Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an

error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the
Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print
data 90 degrees to the right during printing, clear this item.

Important
• Do not change this setting while the print job is displayed in the print wait list. Otherwise,

characters may be omitted or the layout may become corrupt.

Ink Drying Wait Time
You can set the length of the printer rest time until printing of the next page begins. Moving the
slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page
dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

The printer operates with the modified settings hereafter.
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Tips for Ensuring Optimal Printing Quality

Useful Information about Ink

Key Points to Successful Printing

Be Sure to Make Paper Settings after Loading Paper

Storing Printed Images

Printer Handling Precautions

Key to Enjoying Consistent Printing Quality

Precautions for Safe Transport of the Printer
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Useful Information about Ink

How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing. Ink is not only used for printing, but also for cleaning the
print head to maintain the optimal printing quality.

The printer has the function to automatically clean the ink jet nozzles to prevent clogging. In the cleaning
procedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning is limited to a small amount.

Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.
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Key Points to Successful Printing

Check the printer status before printing!

• Is the print head OK?

If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the nozzle check
pattern to check the print head.

Maintenance Procedure

• Is the inside of the printer smeared with ink?

After printing large quantities of paper, the area where papers go through may get smeared with ink.
Clean the inside of your printer with Bottom Plate Cleaning.

Check how to load the paper correctly!

• Is the paper loaded in the correct orientation?

To load paper in the rear tray, load paper WITH THE PRINTING SIDE FACING YOU.

Loading Paper

• Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, then reload it.

"Load the paper after correcting its curl." in Paper Is Smudged/Printed Surface Is Scratched
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Be Sure to Make Paper Settings after Loading Paper

If the media type setting is not the one for the loaded paper, printing results may not be satisfactory. After
loading paper, be sure to select the appropriate media type setting for the loaded paper.

Print Results Not Satisfactory

There are various types of paper: paper with special coating on the surface for printing photos with optimal
quality and paper suitable for documents.

Each media type has specific preset settings, such as how ink is used and sprayed, distance from nozzles,
etc., so that you can print on that type with optimal image quality.

This allows you to print with the settings best suited for the loaded media type just by selecting that media
type.
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Storing Printed Images

Store printed images in albums, clear photo sleeves, or glass frames to protect them from direct exposure to
air.

Note
• Storing printed images without sufficient drying may cause blurring or discoloration.
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Printer Handling Precautions

Do not place any object on the printer!

Do not place any object on the printer. It will fall into the rear tray and cause the printer to malfunction.
Also, place the printer where objects will not fall on it.
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Key to Enjoying Consistent Printing Quality

The key to printing with the optimal printing quality is to prevent the print head from drying or clogging.
Always observe the following rules for optimal printing quality.

Never unplug the power cord until the power is turned off!

If you press the ON/RESUME button to turn off the power, the printer caps the print head (nozzles)
automatically to prevent from drying. If you unplug the power cord from the wall outlet while the POWER
lamp is lit or flashing, the print head will not be capped properly and this will cause drying or clogging.

When unplugging the power cord, make sure that the POWER lamp is not lit.

Print periodically!

Just as the tip of a felt pen becomes dry and unusable if it has not been used for a long time, even if it is
capped, the print head too, may become dried or clogged if the printer has not been used for a long time.

We recommend you to use the printer at least once a month.

Note
• Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or

paint-stick, or bleed if water or sweat comes in contact with the printed area.
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Precautions for Safe Transport of the Printer

When relocating the printer, make sure of the following.

Important
• Pack the printer in a sturdy box so that it is placed with its bottom facing down, using sufficient

protective material to ensure safe transport.
• With the FINE cartridge left installed in the printer, press the ON/RESUME button to turn off the power.

This allows the printer to automatically cap the print head, thus preventing it from drying.
• After packing, do not tilt the box containing the printer or turn it on its side or upside down. Doing so

may cause the ink to leak during transport and cause damage to the printer.
• When a shipping agent is handling transport of the printer, have its box marked "THIS SIDE UP" to

keep the printer with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH CARE".

1. Turn the printer off.

2. Confirm that the POWER lamp is off and unplugging the power cord.

Important
• Do not unplug the printer while the POWER lamp is lit or flashing green, as it may cause

malfunction or damage to the printer, making the printer unable to print.

3. Retract the paper output tray and the output tray extension, then close the paper support.

4. Unplug the printer cable from the computer and from the printer, then unplug the power
cord from the printer.

5. Use adhesive tape to secure all the covers on the printer to keep them from opening during
transportation. Then pack the printer in the plastic bag.

6. Attach the protective material to the printer when packing the printer in the box.
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Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to print the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

• Paper money
• Money orders
• Certificates of deposit
• Postage stamps (canceled or uncanceled)
• Identifying badges or insignias
• Selective service or draft papers
• Checks or drafts issued by governmental agencies
• Motor vehicle licenses and certificates of title
• Traveler's checks
• Food stamps
• Passports
• Immigration papers
• Internal revenue stamps (canceled or uncanceled)
• Bonds or other certificates of indebtedness
• Stock certificates
• Copyrighted works/works of art without permission of copyright owner

100



Specifications

General Specifications

Printing resolution (dpi) 4800* (horizontal) x 600 (vertical)

* Ink droplets can be placed with a pitch of 1/4800 inch at minimum.

Interface USB Port:

Hi-Speed USB *

* A computer that complies with Hi-Speed USB standard is required. Since the
Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can be
used at USB 1.1.

Print width 8 inches/203.2 mm

Operating environment Temperature: 41 to 95 °F (5 to 35 °C)

Humidity: 10 to 90 % RH (no condensation)

* The performance of the printer may be reduced under certain temperature
and humidity conditions.

Recommended conditions:

Temperature: 59 to 86 °F (15 to 30 °C)

Humidity: 10 to 80 % RH (no condensation)

* For the temperature and humidity conditions of papers such as photo paper,
refer to the paper's packaging or the supplied instructions.

Storage environment Temperature: 32 to 104 °F (0 to 40 °C)

Humidity: 5 to 95 % RH (no condensation)

Power supply AC 100-240 V, 50/60 Hz

Power consumption Printing: Approx. 8 W

Standby (minimum): Approx. 0.8 W *1*2

OFF: Approx. 0.5 W *1

*1 USB connection to PC

*2 The wait time for standby cannot be changed.

External dimensions Approx. 16.8 (W) x 9.3 (D) x 5.3 (H) inches

Approx. 426 (W) x 235 (D) x 134 (H) mm

* With the Paper Support and Paper Output Tray retracted.

Weight Approx. 5.0 lb (Approx. 2.3 kg)

* With the FINE Cartridges installed.

Canon FINE Cartridge Total 1280 nozzles (BK 320 nozzles, C/M/Y each 320 nozzles)

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.
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Windows

Operating System Windows 8.1*, Windows 8

Windows 7, Windows 7 SP1

Windows Vista SP1, Windows Vista SP2

Windows XP SP3 32-bit only

* Windows 8.1 includes Windows 8.1 Update.

Hard Disk Space 3.1 GB

Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display XGA 1024 x 768

Mac OS

Operating System OS X v10.6.8 - OS X v10.10

(iP2870S/iP2880S: OS X v10.7.5 - OS X v10.10)

Hard Disk Space 1.5 GB

Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display XGA 1024 x 768

Other Supported OS

Some functions may not be available with each OS. Refer to the Canon web site for details on operation with
Windows RT.

• An internet connection is required to use all the Online Manual.
• Windows: Operation can only be guaranteed on a computer with Windows 8.1, Windows 8,

Windows 7, Windows Vista or Windows XP pre-installed.
• Windows: A CD-ROM Drive or internet connection is required during software installation.
• Windows: Internet Explorer 8, 9, 10 or 11 is required to install Easy-WebPrint EX.
• Windows: Some functions may not be available with Windows Media Center.
• Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.
• Windows: XPS Essentials Pack is required to print on Windows XP.
• Mac OS: For Mac OS, an internet connection is required during software installation.

Information in this guide is subject to change without notice.
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Printing

Printing from a Computer
Printing with Application Software that You are Using (Printer Driver)
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Printing from a Computer

Printing with Application Software that You are Using (Printer Driver)
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Printing with Application Software that You are Using (Printer
Driver)

Printing with Easy Setup Basic
Various Printing Methods
Changing the Print Quality and Correcting Image Data
Overview of the Printer Driver
Printer Driver Description
Updating the Printer Driver
Sharing the Printer on a Network

105



Printing with Easy Setup

This section describes the simple procedure for setting the Quick Setup tab so that you can carry out
appropriate printing on this printer.

1. Check that the printer is turned on

2. Load paper on the printer

3. Open the printer driver setup window

4. Select a frequently used profile

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.
When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size
settings are automatically switched to the values that were preset.

5. Select the print quality

For Print Quality, select High, Standard, or Draft according to your purpose.
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Important
• The print quality settings that can be selected may differ depending on a printing profile.

6. Complete the setup

Click OK.
When you execute print, the document is printed with settings that match your purpose.

Important
• When you select the Always Print with Current Settings check box, all settings specified on the

Quick Setup, Main, and Page Setup tabs are saved, and you can print with the same settings from the
next time as well.

• In the Commonly Used Settings window, click Save... to register the specified settings.
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Setting the Media Type with the Printer Driver

When you use this printer, selecting a media type that matches the print purpose will help you achieve the
best print results.
You can use the following media types on this printer.

Commercially available papers

Media name Media Type in the printer driver

Plain Paper (including recycled paper) Plain Paper

Envelopes Envelope

Canon genuine papers (Photo Printing)

Media name <Model No.> Media Type in the printer driver

Photo Paper Plus Glossy II <PP-201> Photo Paper Plus Glossy II

Photo Paper Glossy <GP-501/GP-601> Glossy Photo Paper
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Various Printing Methods

Setting a Page Size and Orientation
Setting the Number of Copies and Printing Order
Setting the Stapling Margin
Fit-to-Page Printing
Scaled Printing
Page Layout Printing
Tiling/Poster Printing
Booklet Printing
Duplex Printing
Stamp/Background Printing
Registering a Stamp
Registering Image Data to be Used as a Background
Setting Up Envelope Printing
Displaying the Print Results before Printing
Setting Paper Dimensions (Custom Size)
Editing the Print Document or Reprinting from the Print History
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:
You can also set page size and orientation on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.

3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.

Note
• If Normal-size is selected for Page Layout, then Automatically reduce large document that the

printer cannot output is displayed.
Normally, you can leave the check box checked. During printing, if you do not want to reduce large
documents that cannot be printed on the printer, uncheck the check box.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:
You can also set the number of copies on the Quick Setup tab.

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.

3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.
Check the Collate check box when you are printing multiple copies of a document and want to print out
all pages in each copy together. Uncheck this check box when you want to print all pages with the same
page number together.

• Print from Last Page:  /Collate: 

• Print from Last Page:  /Collate: 

• Print from Last Page:  /Collate: 
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• Print from Last Page:  /Collate: 

4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

Important
• When the application software that you used to create the document has the same function, specify the

settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.

• Print from Last Page appears grayed out and is unavailable when Tiling/Poster is selected for Page
Layout.

• When Booklet is selected for Page Layout, Print from Last Page and Collate appear grayed out and
cannot be set.

• When Duplex Printing (Manual) is selected, Print from Last Page appears grayed out and cannot be
set.

Note
• By setting both Print from Last Page and Collate, you can perform printing so that papers are collated

one by one starting from the last page.
These settings can be used in combination with Normal-size, Fit-to-Page, Scaled, and Page Layout.
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Setting the Stapling Margin

The procedure for setting the staple side and the margin width is as follows:

1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Stapling Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
staple position. When you want to change the setting, select from the list.

3. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.
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Note
• The printer automatically reduces the print area depending on the staple position margin.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin width.

Important
• Stapling Side and Specify Margin... appear grayed out and are unavailable when:

• Tiling/Poster or Booklet is selected for Page Layout
• Scaled is selected for Page Layout (When Duplex Printing (Manual) is also selected, only

Stapling Side can be specified.)
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Fit-to-Page Printing

The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be
used is as follows:

1. Open the printer driver setup window

2. Set fit-to-page printing

Select Fit-to-Page from the Page Layout list on the Page Setup tab.

3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When the
Printer Paper Size is larger than the Page Size, the page image will be enlarged.

The current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK.
When you execute print, the document will be enlarged or reduced to fit to the page size.
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Scaled Printing

The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Set scaled printing

Select Scaled from the Page Layout list on the Page Setup tab.

3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Set the scaling rate by using one of the following methods:

• Select a Printer Paper Size

When the printer paper size is smaller than the Page Size, the page image will be reduced. When
the printer paper size is larger than the Page Size, the page image will be enlarged.
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• Specify a scaling factor

Directly type in a value into the Scaling box.

The current settings are displayed in the settings preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

Important
• When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in
the printer driver.
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Note
• Selecting Scaled changes the printable area of the document.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of paper.

The procedure for performing page layout printing is as follows:

1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.
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Pages
To change the number of pages to be printed on a single sheet of paper, select the number of
pages from the list.

Page Order
To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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Tiling/Poster Printing

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for performing tiling/poster printing is as follows:

Setting Tiling/Poster Printing

1. Open the printer driver setup window

2. Set tiling/poster printing

Select Tiling/Poster from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of image divisions and the pages to be printed
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If necessary, click Specify..., specify the following settings in the Tiling/Poster Printing dialog box,
and then click OK.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create
a larger poster.

Print "Cut/Paste" in margins
To leave out words "Cut" and "Paste", uncheck this check box.

Note
• This feature may be unavailable when certain printer drivers or operating environments are

used.

Print "Cut/Paste" lines in margins
To leave out cut lines, uncheck this check box.

Print page range
Specifies the printing range. Select All under normal circumstances.
To reprint only a specific page, select Pages and enter the page number you want to print. To
specify multiple pages, enter the page numbers by separating them with commas or by entering a
hyphen between the page numbers.

Note
• You can also specify the print range by clicking the pages in the settings preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.

Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the
procedure below:

1. Set the print range

In the settings preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.
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Note
• Click the deleted pages to display them again.
• Right-click the settings preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

Important
• Since tiling/poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the
paper. This type of printing ensures that pages can be collated properly, in page number order, when the
printed sheets are folded and stapled at the center.

The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the window.

3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click OK.
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Margin for stapling
Select which side should the stapling margin be on when the booklet is completed.

Insert blank page
To leave one side of a sheet blank, check the check box, and select the page to be left blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin width
for one page.

Page Border
To print a page border around each document page, check the check box.

5. Complete the setup

Click OK on the Page Setup tab.

When you execute print, the document will be printed on one side of a sheet of paper. When the printing
of one side is complete, set the paper correctly by following the message and click OK.
When the printing of the other side is complete, fold the paper at the center of the margin and make a
booklet.

Important
• Booklet cannot be selected when a media type other than Plain Paper is selected for Media Type on

the Main tab.

Note
• The stamp and background are not printed on the inserted blank sheets with the Insert blank page

function of booklet printing.
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Duplex Printing

The procedure for printing data on both sides of a sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set duplex printing

Check the Duplex Printing (Manual) check box on the Page Setup tab.

3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

5. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.

6. Complete the setup
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Click OK on the Page Setup tab.

When you execute print, the document is first printed on one side of a sheet of paper. After one side is
printed, reload the paper correctly according to the message.
Then click Start Printing to print the opposite side.

Important
• When a media type other than Plain Paper is selected from Media Type on the Main tab, Duplex

Printing (Manual) appears grayed out and is unavailable.
• When Tiling/Poster or Booklet is selected from the Page Layout list, Duplex Printing (Manual) and

Stapling Side appear grayed out and are unavailable.

Note
• If the back side of the paper becomes smudged during duplex printing, perform Bottom Plate Cleaning

in the Maintenance tab.

Related Topics

Cleaning Inside the Printer
Changing the Printer Operation Mode
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Stamp/Background Printing

Stamp or Background may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light illustration
behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a Stamp

"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab

The Stamp/Background (Stamp) dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and only the stamp function can be used.
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3. Select a stamp

Check the Stamp check box, and select the stamp to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the stamp details

If necessary, specify the following settings, and then click OK.

Define Stamp... button
To change the stamp text, bitmap, or position, click this.

Place stamp over text
To print the stamp on the front of the document, check this check box.

Note
• The stamp is given priority because the stamp is printed over the document data in the

sections where the stamp and the document data overlap. When this check box is
unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application software used.

• Place stamp over text cannot be used when the XPS printer driver is used.
When the XPS printer driver is used, the stamp is normally printed in the foreground of the
document.

Print semitransparent stamp
Check this check box to print a semi-transparent stamp on the document.
This function is available only when the XPS printer driver is used.

Stamp first page only
To print the stamp only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a Background

Two bitmap files are pre-registered as samples.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

3. Select the background

Check the Background check box, and select the background to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the background details

If necessary, complete the following settings, and then click OK.
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Select Background... button
To use another background or change the layout or density of a background, click this.

Background first page only
To print the background only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

Note
• The stamp and background are not printed on blank sheets inserted with the Insert blank page

function of booklet printing.

Related Topics

Registering a Stamp
Registering Image Data to be Used as a Background
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab

The Stamp/Background (Stamp) dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and only the stamp function can be used.

3. Click Define Stamp...

The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window

• Stamp tab

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type.
◦ For Text registration, the characters must already be entered in Stamp Text. If necessary,

change the TrueType Font, Style, Size, and Outline settings. You can select the color of
the stamp by clicking Select Color....

◦ For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,
change the settings of the Size and Transparent white area.

◦ For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size,
and Outline. You can select the color of the stamp by clicking Select Color....

Important
• Stamp Text appears grayed out and is unavailable when Date/Time/User Name is

selected.

• Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.
You can also change the stamp position by dragging the stamp in the preview window.
To change the stamp position angle, type a value in the Orientation box directly.

Important
• Orientation cannot be changed when Bitmap is selected for Stamp Type on the Stamp tab.

5. Save the stamp

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.
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6. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select the stamp for which the settings are to be changed

Select the Stamp check box in the Stamp/Background (Stamp) dialog box. Then from the list, select
the title of the stamp to be changed.

2. Click Define Stamp...

The Stamp Settings dialog box opens.

3. Configure the stamp while viewing the preview window

4. Overwrite save the stamp

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Deleting an Unnecessary Stamp

1. Click Define Stamp... in the Stamp/Background (Stamp) dialog box

The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
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Registering Image Data to be Used as a Background

This feature may be unavailable when certain printer drivers or operating environments are used.

You can select a bitmap file (.bmp) and register it as a new background. You can also change and register
some of the settings of an existing background. An unnecessary background can be deleted.

The procedure for registering image data to be used as a background is as follows:

Registering New Background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button

and Background cannot be used.

3. Click Select Background...

The Background Settings dialog box opens.
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4. Select the image data to be registered to the background

Click Select File.... Select the target bitmap file (.bmp), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method
Select how the background image data is to be placed.
When Custom is selected, you can set coordinates for X-Position and Y-Position.
You can also change the background position by dragging the image in the preview window.

Intensity
Set the intensity of the background image data with the Intensity slider. Moving the slider to the
right darkens the background, and moving the slider to the left lightens the background. To print
the background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

7. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Changing and Registering Some Background Settings

1. Select the background for which the settings are to be changed

Select the Background check box in the Stamp/Background dialog box. Then from the list, select
the title of the background you want to change.

2. Click Select Background...
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The Background Settings dialog box opens.

3. Specify each item on the Background tab while viewing the preview window

4. Save the background

Click Save overwrite on the Save settings tab. When you want to save the background with a
different title, enter a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Deleting an Unnecessary Background

1. Click Select Background... in the Stamp/Background dialog box

The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
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Setting Up Envelope Printing

The procedure for performing envelope printing is as follows:

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Commonly Used Settings on the Quick Setup tab.

4. Select the paper size

When the Envelope Size Setting dialog box is displayed, select Envelope Com 10, Envelope DL, and
then click OK.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

6. Select the print quality

Select High or Standard that matches your purpose for Print Quality.

7. Complete the setup

Click OK.
When you execute print, the information is printed on the envelope.
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Displaying the Print Results before Printing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when
reading this information.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

You can also set the print results display on the Quick Setup tab.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
When you execute print, the Canon IJ Preview opens and displays the print results.

Important
• In the Manual Color Adjustment dialog box, the Color Adjustment tab contains the Print a pattern

for color adjustment check box. When this check box is selected, the Preview before printing
appears grayed out and is unavailable.

Related Topic

Canon IJ Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

The procedure for specifying a custom size is as follows:

You can also set a custom size in Printer Paper Size on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select Custom... for Page Size on the Page Setup tab.

The Custom Paper Size dialog box opens.

3. Set the custom paper size

Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.

140



Important
• When the application software that created the document has a function for specifying the height and

width values, use the application software to set the values. When the application software does not
have such a function or if the document does not print correctly, use the printer driver to set the values.

• Printing may be disabled depending on the size of the specified user-defined media.
For information about printable sizes for user-defined media, see "Media Types You Can Use."
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Editing the Print Document or Reprinting from the Print History

This function is unavailable when the standard IJ printer driver is used.

In the Canon IJ XPS preview window, you can edit the print document or retrieve the document print history
to print the document.

The procedure for using the Canon IJ XPS Preview is as follows:

Print

Combine Documents

Delete Document

Reset Documents

View Thumbnails

Move Document

Undo

Move Page

Delete Page

Note

• By clicking  View Thumbnails, you can display or hide thumbnails of the print documents selected
in the Document Name list.

• Clicking  Undo reverses the change that just performed.
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Editing and Printing a Print Document

When printing multiple documents or pages, you can combine documents, change the print sequence of
the documents or pages, or delete documents or pages.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
The Canon IJ XPS Preview will start and the print result will be displayed before printing.

4. Editing print documents and print pages

• Combining print documents

You can combine multiple print documents to form a single document. By combining print
documents, you can prevent blank pages from being inserted when you execute duplex printing
or page layout printing.
From the Document Name list, select the documents to be combined. On the Edit menu, select
Combine Documents from Documents to combine the documents in the listed sequence.
To select multiple print documents, hold down the Ctrl key and click the documents to be
merged, or hold down the Shift key and press the upper arrow or lower arrow key. You can also
click a blank area in the document list and drag the mouse to select multiple documents.
When you combine documents, the documents selected before the combining are deleted from
the list and the combined document is added to the list.

• Changing the sequence of print documents or print pages

◦ To change the sequence of the print documents, go to the Document Name list, and select
the print document to be moved. Next, on the Edit menu, select Move Document from
Documents, and select the appropriate item. You can also click and drag a print document
to change the print sequence.

◦ To change the sequence of the print pages, click View Thumbnails from the Option menu,
and select the print page to be moved. Next, on the Edit menu, select Move Page from
Pages, and select the appropriate item. You can also click and drag a print page to change
the print sequence.

• Deleting print documents and print pages

◦ To delete a print document, select the target document from the Document Name list, and
on the Edit menu, choose Documents and then Delete Document.

◦ To delete a print page, click View Thumbnails from the Option menu, and select the print
page to be deleted. Next, on the Edit menu, select Delete Page from Pages.

• Print page recovery

You can recover pages that were deleted with Delete Page.
To recover pages, select the View Deleted Pages check box from the Option menu, and select
the pages to be recovered from among the displayed thumbnail pages. Then from the Edit menu
chose Pages and then Restore Page.
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After editing the print documents or print pages, you can change the print settings on the Page
Information, Layout and Manual Color Adjustment tabs as necessary.

Important
• To display the multiple documents in the list, open the preview and execute print again.
• To return the print documents to their original condition before they were edited in the preview,

on the Edit menu, select Reset Documents from Documents.
• If the documents to be combined have different print settings, a message may be displayed.

Check the contents of the displayed message before combining the documents.
• If the documents to be combined have different output paper sizes and duplex printing or page

layout printing is to be performed, the printer may not produce the expected print results for
certain print pages.
Check the preview before printing.

• Depending on the print settings of the print document, some functions may not be available in
the Canon IJ XPS preview.

Note
• You can rename Document Name to any name.

5. Executing print

Click Print.
When you execute print, the printer uses the specified settings to print the data.

Reprinting from the Print History

When you click Save Print History on the File menu to enable the setting, the document printed from the
preview is saved, and you can reprint the document with the same settings.

1. Displaying the print history

Open the printer driver setup window. Then on the Maintenance tab, select View Print History.
The saved print document is displayed in the preview.

Important
• To limit the number of print history registrations, click History Entry Limit on the File menu.
• If the limit on the number of registration is exceeded, the print history registrations are deleted

starting from the oldest one.

2. Selecting a print document

From the Document Name list, select the document to be printed.

3. Executing print

Click Print.

Related Topic

Displaying the Print Results before Printing
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Changing the Print Quality and Correcting Image Data

Setting the Print Quality Level (Custom)
Printing a Color Document in Monochrome
Specifying Color Correction
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Setting the Print Quality Level (Custom)

The print quality level can be set in the Custom.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select the print quality

On the Main tab, select Custom for Print Quality, and click Set....

The Custom dialog box opens.

3. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.
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Related Topics

Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

You can also set a grayscale printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.

3. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

Important
• When the Grayscale Printing check box is checked, the printer driver processes image data as sRGB

data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data
using an application software.
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Note
• During Grayscale Printing, inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed with
color tints that most people prefer. This method is suitable for printing sRGB data.

When you want to print by using the color space (Adobe RGB or sRGB) of the image data effectively, select
ICM (ICC Profile Matching). When you want to use an application software to specify a printing ICC profile,
select None.

The procedure for specifying color correction is as follows:

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
With Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

None
The printer driver does not perform color correction. Select this value when you are specifying an
individually created printing ICC profile in an application software to print data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

Important
• When ICM is disabled in the application software, ICM is unavailable for Color Correction and the

printer may not be able to print the image data properly.
• When the Grayscale Printing check box on the Main tab is checked, Color Correction appears

grayed out and is unavailable.

Related Topics

Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.
To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
Adobe RGB and sRGB are popularly used as common color spaces. Adobe RGB has a wider color space
than sRGB.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space (Adobe RGB or sRGB) of the image data
or the application software to be used.

There are two typical printing methods.
Check the color space (Adobe RGB or sRGB) of the image data and the application software to be used,
and then select the printing method suited to your purpose.

Adjusting Colors with the Printer Driver
Describes the procedure for printing sRGB data by using the color correction function of the printer
driver.

• To print using Canon Digital Photo Color

The printer prints data with color tints that most people prefer, reproducing colors of the original
image data and producing three-dimensional effects and high, sharp contrasts.

• To print by directly applying editing and touch-up results of an application software

When printing the data, the printer brings out subtle color difference between dark and light
areas, while leaving the darkest and lightest areas intact.
When printing the data, the printer applies fine adjustment results, such as brightness
adjustments made with an application software.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of Adobe RGB or sRGB effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print sRGB data with color tints that most
people prefer through the use of Canon Digital Photo Color.
When printing from an application software that can identify ICC profiles and allows you to specify them, use
a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.

4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
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Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space (Adobe RGB
or sRGB) of the data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.
Even if you print using a printing ICC profile that you created yourself from your application software, be
sure to select color management items from your application software.
For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select None for Color Correction.

4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.
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5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Specify an ICC Profile with the Printer Driver, and then Print

Print from an application software that cannot identify input ICC profiles or does allow you to specify one
by using the color space of the input ICC profile (sRGB) found in the data. When printing Adobe RGB
data, you can print the data with the Adobe RGB color space even if the application software does not
support Adobe RGB.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select ICM (ICC Profile Matching) for Color Correction.

4. Select the input profile

Select an Input Profile that matches the color space of the image data.

• For sRGB data or data without an input ICC profile:

Select Standard.
• For Adobe RGB data:

Select Adobe RGB (1998).
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Important
• When the application software specifies an input profile, the input profile setting of the printer

driver becomes invalid.
• When no input ICC profiles are installed on your computer, Adobe RGB (1998) will not be

displayed.

5. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints when printing.
Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.
The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

No adjustment Adjust color balance

The procedure for adjusting color balance is as follows:

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust color balance
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There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved
to the left. For example, when cyan becomes weaker, the color red becomes stronger.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.

Important
• Adjust the slider gradually.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

Important
• When the Grayscale Printing check box on the Main tab is checked, the color balance (Cyan,

Magenta, Yellow) appear grayed out and are unavailable.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Color Balance Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the color balance.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the color balance while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....

160



4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.

Parameters to Adjust
Select Cyan/Magenta/Yellow.

Important
• When the Grayscale Printing check box on the Main tab is checked, Cyan/Magenta/Yellow

appear grayed out and are unavailable.

Printer Paper Size
Select the paper size to be used for pattern printing.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.
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Note
• Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
color balance that you set is the center value.

Important
• Normally, patterns are printed with the color balance settings as the center values. However,

when Black Only is selected for Ink Cartridge Settings on the Maintenance tab, the color
balance settings are not applied to pattern printing.

6. Adjusting the color balance

Look at the print results and select the image that you like best. Then enter the color balance numbers
indicated at the bottom of that image into the Cyan, Magenta, and Yellow fields on the Color
Adjustment tab.
Clear the Print a pattern for color adjustment check box, and click OK.
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Note
• You can also set color balance on the Quick Setup tab by choosing Photo Printing under

Commonly Used Settings, and then choosing Color/Intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the color balance that was adjusted by the
pattern print function.

Important
• When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following

items are grayed out and cannot be set:
• Preview before printing on the Main tab
• Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is

set, only Stapling Side can be set.)

• You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
• When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow

appear grayed out and are unavailable.
• Depending on your application software, this function may not be available.

Related Topics

Adjusting Color Balance
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Brightness

You can change the brightness of the overall image data during printing.
This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.
The following sample shows the print result when the brightness setting is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Specify the brightness

Select Light, Normal, or Dark for Brightness, and click OK. The current settings are displayed in the
settings preview on the left side of the printer driver.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Intensity
Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.
The following sample shows the case when the intensity is increased so that all colors become more intense
when the image data is printed.

No adjustment Higher intensity

The procedure for adjusting intensity is as follows:

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors, and moving the slider to the left
dilutes (brightens) the colors.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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Important
• Adjust the slider gradually.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Contrast

You can adjust the image contrast during printing.
To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Adjust the contrast

Moving the Contrast slider to the right increases the contrast, and moving the slider to the left decreases
the contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.
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After adjusting each color, click OK.

Important
• Adjust the slider gradually.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

Setting the Print Quality Level (Custom)
Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the intensity/contrast.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the intensity/contrast while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.

Parameters to Adjust
Select Intensity/Contrast.

Printer Paper Size
Select the paper size to be used for pattern printing.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.

Note
• Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print
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On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
intensity/contrast that you set is the center value.

6. Adjusting the intensity/contrast

Look at the print results and select the image that you like best. Then enter the intensity/contrast
numbers indicated at the bottom of that image into the Intensity and Contrast fields on the Color
Adjustment tab.
Clear the Print a pattern for color adjustment check box, and click OK.
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Note
• You can also set intensity/contrast on the Quick Setup tab by choosing Photo Printing under

Commonly Used Settings, and then choosing Color/Intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the intensity/contrast that was adjusted by
the pattern print function.

Important
• When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following

items are grayed out and cannot be set:
• Preview before printing on the Main tab
• Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is

set, only Stapling Side can be set.)

• You can print a pattern only if Normal-size is selected for Page Layout on the Page Setup tab.
• Depending on your application software, this function may not be available.

Related Topics

Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity
Adjusting Contrast
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Overview of the Printer Driver

Canon IJ Printer Driver
How to Open the Printer Driver Setup Window
Canon IJ Status Monitor
Checking the Ink Status from Your Computer
Canon IJ Preview
Deleting the Undesired Print Job
Instructions for Use (Printer Driver)
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Canon IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific
model you are using.

Printer Driver Types

On Windows Vista SP1 or later, you can install the XPS printer driver in addition to the regular printer
driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

Important
• To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

• To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

• To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX" (where "XXX" is your model name) to specify the regular printer driver or select "XXX XPS"
(where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

Note
• Depending on application software you use, command names or menu names may vary and

there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

• If you are using Windows 8, from the Desktop charms, select Settings -> Control Panel ->
Hardware and Sound -> Devices and Printers.

• If you are using Windows 7, select the Start menu -> Devices and Printers.
• If you are using Windows Vista, select the Start menu -> Control Panel -> Hardware and

Sound -> Printers.
• If you are using Windows XP, select the start menu -> Control Panel -> Printers and Other

Hardware -> Printers and Faxes.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

Important
• Opening the printer driver setup window through Printer properties (Windows 8, Windows 7)

or Properties (Windows Vista, Windows XP) displays such tabs regarding the Windows
functions as the Ports (or Advanced) tab. Those tabs do not appear when opening through
Printing preferences or application software. For tabs regarding Windows functions, refer to
the user's manual for the Windows.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.

Click the button of the status monitor displayed on the task bar. The Canon IJ Status Monitor appears.

Note
• To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup

window and click View Printer Status on the Maintenance tab.
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of
paper or if the ink is low).

In such cases, take the appropriate action as described.
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Checking the Ink Status from Your Computer

You can check the remaining ink level and the FINE cartridge types for your model.

1. Open the printer driver setup window

2. Launching the Canon IJ Status Monitor

On the Maintenance tab, click View Printer Status.
The Canon IJ Status Monitor opens and displays an image of the ink status.

Note
• The information displayed on the Canon IJ Status Monitor may differ depending on the country or

region where you are using your printer.
• When you receive a notice about the remaining ink level, a mark appears above the ink icon.

For example: 
The ink is running low. Prepare a new ink cartridge.

3. If necessary, click Ink Details

You can check the ink-related information.

If a warning or error related to the remaining ink amount occurs, a notification icon is displayed at the top
of the image in the Ink Details dialog box.
In such cases, take the appropriate action as described on the screen.

Note
• You can also display the Ink Details dialog box by selecting the ink icon on the Canon IJ Status

Monitor.
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Canon IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

Important
• If you are using the XPS printer driver, see "Editing the Print Document or Reprinting from the Print

History."

Related Topic

Displaying the Print Results before Printing
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon IJ Status Monitor" with "Canon IJ XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the icon of the Canon IJ Status Monitor displayed on the task bar.
The Canon IJ Status Monitor appears.

2. Display the print jobs

Click Display Print Queue.
The print queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

Important
• Users who have not been granted access permission for printer management cannot delete the print

job of another user.

Note
• When you perform this operation, all print jobs are deleted. If the print queue list contained a necessary

print job, start the printing process over from the beginning.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

• With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.

• If the selected Language in the About dialog box of the Maintenance tab does not match the
operating system interface language, the printer driver setup window may not be displayed properly.

• Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.

◦ Preview before printing on the Main tab
◦ Prevention of Print Data Loss in the Print Options dialog box on the Page Setup tab
◦ Page Layout, Tiling/Poster, Booklet, Duplex Printing (Manual), Specify Margin..., Print from

Last Page, Collate, and Stamp/Background... (Stamp...) on the Page Setup tab
◦ Print a pattern for color adjustment on the Color Adjustment tab in the Manual Color

Adjustment dialog box

• Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

• With some applications, the printing is divided into multiple print jobs.
To cancel printing, delete all divided print jobs.

• If image data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

Note
• Disable ICM required from the application software cannot be used when the XPS printer

driver is used.

Points to Note About Applications with Restrictions

• There are following restrictions in Microsoft Word (Microsoft Corporation).
◦ When Microsoft Word has the same printing functions as the printer driver, use Word to specify

them.
◦ When Fit-to-Page, Scaled, or Page Layout is used for Page Layout on the Page Setup tab of

the printer driver, the document may not print normally in certain versions of Word.
◦ When Page Size in Word is set to "XXX Enlarge/Reduce", the document may not print normally in

certain versions of Word.
If this happens, follow the procedure below.

1. Open Word's Print dialog box.
2. Open the printer driver setup window, and on the Page Setup tab, set Page Size to the same

paper size that you specified in Word.
3. Set the Page Layout that you want, and then click OK to close the window.
4. Without starting printing, close the Print dialog box.
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5. Open Word's Print dialog box again.
6. Open the printer driver setup window and click OK.
7. Start printing.

• If bitmap printing is enabled in Adobe Illustrator (Adobe Systems Incorporated), printing may take time
or some data may not be printed. Print after unchecking the Bitmap Printing check box in the Print
dialog box.
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Printer Driver Description

Quick Setup tab Description
Main tab Description
Page Setup tab Description
Maintenance tab Description
Canon IJ Preview Description
Canon IJ XPS Preview Description
Canon IJ Status Monitor Description
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Quick Setup tab Description

The Quick Setup tab is for registering commonly used print settings. When you select a registered setting,
the printer automatically switches to the preset items.

Commonly Used Settings
The names and icons of frequently used printing profiles are registered. When you select a printing
profile according to the purpose of the document, settings that match the purpose are applied.
In addition, functions that are thought to be useful for the selected printing profile are displayed in
Additional Features.
You can also change a printing profile and register it under a new name. You can delete the registered
printing profile.
You can rearrange the profiles either by dragging the individual profiles or by holding down the Ctrl key
and pressing the up or down arrow keys.
Standard

These are the factory settings.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Photo Printing
If you select this setting when printing a photo, the photo paper and photo size generally used are
set.
If Orientation and Copies were set from the application software, those settings have priority.

Business Document
Select this setting when printing a general document.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Paper Saving
Select this setting to save paper when printing a general document. The 2-on-1 Printing and
Duplex Printing (Manual) check boxes are checked automatically.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.
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Envelope
If you select this setting for printing an envelope, Media Type is set automatically to Envelope. In
the Envelope Size Setting dialog box, select the size of the envelope to be used.

Note
• The combination of the Additional Features that was displayed for the printing profile that had

been selected when the added printing profile was saved is also displayed when that added
printing profile is selected.

Save...
Displays the Save Commonly Used Settings dialog box.
Click this button when you want to save the information that you set on the Quick Setup, Main, and
Page Setup tabs to Commonly Used Settings.

Delete
Deletes a registered printing profile.
Select the name of the setting to be deleted from Commonly Used Settings, and click Delete. When a
confirmation message is displayed, click OK to delete the specified printing profile.

Note
• Printing profiles that are registered in the initial settings cannot be deleted.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.
Uncheck this check box if you do not want to display a preview.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile

installed on your computer.

Additional Features
Displays the frequently used, convenient functions for the printing profile that you selected for
Commonly Used Settings on the Quick Setup tab.
When you move the mouse pointer near a function that can be changed, a description of that function is
displayed.
To enable a function, check the corresponding check box.
For some functions, you can set detailed settings from the Main and Page Setup tabs.

Important
• Depending on the printing profiles, certain function may be grayed out and you will not be able to

change them.

2-on-1 Printing
Prints two pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.
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4-on-1 Printing
Prints four pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
To change the staple side or the margins, set the new values from the Page Setup tab.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Draft
This setting is appropriate for test printing.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application
software will be reversed vertically and horizontally.

Color/Intensity Manual Adjustment
Select when you set the Color Correction method and individual settings such as Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast, etc.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
Normally, the paper size is set automatically according to the output paper size setting, and the
document is printed with no scaling.
When you set 2-on-1 Printing or 4-on-1 Printing in Additional Features, you can manually set the
paper size with Page Size on the Page Setup tab.
If you select a paper size that is smaller than the Page Size, the page image will be reduced.
If you select a paper size that is larger than the Page Size, the page image will be enlarged.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.
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Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
To set the print quality level individually, click the Main tab, and for Print Quality, select Custom. The
Set... becomes enabled. Click Set... to open the Custom dialog box, and then specify the desired
settings.
High

Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.

Draft
This setting is appropriate for test printing.

Paper Source
Shows the source from which paper is supplied.
Rear Tray

Paper is always supplied from the rear tray.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• When the application software that you used to create the document has the same function,

specify the settings on the printer driver. However, if the print results are not acceptable, specify
the function settings on the application software.

Always Print with Current Settings
Prints documents with the current settings starting from the next print execution.
When you select this function and then close the printer driver setup window, the information that you
set on the Quick Setup, Main, and Page Setup tabs are saved and printing with the same settings is
possible starting from the next print execution.

Important
• If you log on with a different user name, the settings that were set when this function was enabled

are not reflected in the print settings.
• If a setting was specified on the application software, it has priority.

Defaults
Restores all the settings you have changed to their default values.
Click this button to return all settings on the Quick Setup, Main, and Page Setup tabs to their default
values (factory settings).

Save Commonly Used Settings dialog box

This dialog box allows you to save the information that you set on the Quick Setup, Main, and Page
Setup tabs and add the information to the Commonly Used Settings list on the Quick Setup tab.

Name
Enter the name for the printing profile you wish to save.
Up to 255 characters can be entered.
The name appears, with its associated icon, in the Commonly Used Settings list on the Quick
Setup tab.
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Options...
Opens the Save Commonly Used Settings dialog box.
Changes the details of printing profile to be saved.

Save Commonly Used Settings dialog box

Select the icons of the printing profiles to be registered to Commonly Used Settings, and change the
items to be saved in the printing profiles.

Icon
Select the icon for the printing profile you wish to save.
The selected icon appears, with its name, in the Commonly Used Settings list on the Quick
Setup tab.

Save the paper size setting
Saves the paper size to the printing profile in Commonly Used Settings.
To apply the saved paper size when the printing profile is selected, check this check box.
If this check box is unchecked, the paper size is not saved, and consequently the paper size setting
is not applied when the printing profile is selected. Instead the printer prints with the paper size
specified with the application software.

Save the orientation setting
Saves the Orientation to the printing profile in Commonly Used Settings.
To apply the saved print orientation when the printing profile is selected, check this check box.
If this check box is unchecked, the print orientation is not saved, and consequently the Orientation
setting is not applied when the printing profile is selected. Instead the printer prints with the print
orientation specified with the application software.

Save the copies setting
Saves the Copies setting to the printing profile in Commonly Used Settings.
To apply the saved copies setting when the printing profile is selected, check this check box.
If this check box is unchecked, the copies setting is not saved, and consequently the Copies
setting is not applied when the printing profile is selected. Instead the printer prints with the copies
setting specified with the application software.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Related Topics

Printing with Easy Setup
Setting a Page Size and Orientation
Setting the Number of Copies and Printing Order
Duplex Printing
Setting Up Envelope Printing
Displaying the Print Results before Printing
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Setting Paper Dimensions (Custom Size)
Printing a Color Document in Monochrome
Specifying Color Correction
Adjusting Color Balance
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Registering a Frequently Used Printing Profile
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Main tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Paper Source
Shows the source from which paper is supplied.
Rear Tray

Paper is always supplied from the rear tray.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

Important
• Depending on the Media Type settings, the same print results may be produced even if the Print

Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.

Draft
This setting is appropriate for test printing.
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Custom
Select this when you want to set the printing quality level individually.

Set...
Select Custom for Print Quality to enable this button.
Open the Custom dialog box. You can then individually set the print quality level.

Color/Intensity
Selects color adjustment method.
Auto

Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast, and so on are adjusted
automatically.

Manual
Select when you set the individual settings such as Cyan, Magenta, Yellow, Brightness,
Intensity, and Contrast, etc. and Color Correction method.

Set...
Select Manual for Color/Intensity to enable this button.
In the Manual Color Adjustment dialog box, you can adjust individual color settings such as
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast on the Color Adjustment tab, and
select the Color Correction method on the Matching tab.

Note
• If you want to use an ICC profile to adjust colors, use the Manual Color Adjustment dialog

box to set the profile.

Grayscale Printing
This function converts the data to monochrome data when printing your document.
Check this check box to print a color document in monochrome.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile

installed on your computer.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).

Custom dialog box

Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.

Important
• Certain print quality levels cannot be selected depending on the settings of Media Type.
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Note
• The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when

the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding radio button is selected for Print Quality on the Main tab.

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, Intensity, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted. You can check the color adjustment
status easily by changing the preview image to one similar to the results to be printed with Sample
Type.

Note
• The graphic is in monochrome when the Grayscale Printing check box is checked.

Sample Type
Selects a preview image displayed on the Color Adjustment tab.
If necessary, select a preview image from Standard, Portrait, Landscape, or Graphics, whichever
is most similar to the print results.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

Important
• When Grayscale Printing is checked on the Main tab, Cyan, Magenta, and Yellow appear

grayed out and are unavailable.

Brightness
Selects the brightness of your print.
You cannot change the levels of pure white and black. However, the brightness of the colors between
white and black can be changed.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
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Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Print a pattern for color adjustment
When the color balance or intensity/contrast is changed, the pattern printing function prints a list of
the adjustment results along with the adjustment values.
Select this function when printing a pattern for color adjustment.

Pattern Print preferences...
Check Print a pattern for color adjustment to enable this button.
The Pattern Print dialog box opens and allows you to set pattern printing settings.

Pattern Print dialog box

Performs the setup for printing of patterns that allow you to check the color balance and intensity/
contrast of documents.

Parameters to Adjust
Select the item to be checked by pattern printing.
Cyan/Magenta/Yellow

Prints a pattern that allows you to check the cyan/magenta/yellow balance.

Important
• When Grayscale Printing is checked on the Main tab, Cyan/Magenta/Yellow appear

grayed out and are unavailable.

Intensity/Contrast
Prints a pattern that allows you to check the intensity/contrast balance.

Printer Paper Size
Selects the paper size to be used for pattern printing.
This setting is linked to Printer Paper Size on the Page Setup tab.

Note
• Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot

be selected.

Amount of Pattern Instances
Sets the number of patterns to be printed.
You can select from Largest, Large, and Small. When you select a pattern size, the number of
patterns that can be printed is as follows:

Note
• Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.
• The setting preview on the Main tab displays an image that allows you to check the overall

layout.

Largest
Cyan/Magenta/Yellow 37
Intensity/Contrast 49
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Large
Cyan/Magenta/Yellow 19
Intensity/Contrast 25

Small
Cyan/Magenta/Yellow 7
Intensity/Contrast 9

Color Variation Between Instances
Sets the amount of color change between neighboring patterns.
Select from Large, Medium, and Small. Large produces a large amount of change, and Small
produces a small amount of change.

Note
• Large is about double the size of Medium, and Small is about half the size of Medium.

Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM (ICC Profile Matching), or None to match the purpose of
the print operation.

Important
• When Grayscale Printing is checked on the Main tab, Color Correction appears grayed out

and is unavailable.

Note
• In the XPS printer driver, ICM has become ICC Profile Matching.

Driver Matching
With Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

Important
• If the application software is set so that ICM is disabled, ICM is unavailable for Color

Correction and the printer may not be able to print the image data properly.

None
Disables color adjustment with the printer driver.

Input Profile
Specifies the input profile to be used when you select ICM (ICC Profile Matching) for Color
Correction.
Standard

The standard printer profile (sRGB), which supports the color space of ICM, is used. This is the
default setting.

Adobe RGB (1998)
The Adobe RGB profile, which supports a wider color space than sRGB, is used.
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Important
• Adobe RGB (1998) is not displayed when input profiles of Adobe RGB are not installed.

Related Topics

Setting the Print Quality Level (Custom)
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Specifying Color Correction
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
Printing a Color Document in Monochrome
Displaying the Print Results before Printing
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Page Setup tab Description

The Page Setup tab allows you to determine how a document is to be arranged on the paper. Also, this tab
allows you to set the number of copies and the order of printing. If the application which created the
document has a similar function, set them with the application.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait

Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application software will
be reversed vertically and horizontally.
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Printer Paper Size
Selects the size of paper actually loaded into the printer.
The default setting is Same as Page Size to perform normal-sized printing.
You can select a printer paper size when you select Fit-to-Page, Scaled, Page Layout, Tiling/Poster,
or Booklet for Page Layout.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger than the Page Size, the document size will be enlarged.

Page Layout
Selects the size of the document you want to print and the type of printing.
Normal-size

This is the normal printing method. Select this when you do not specify any page layout.
Automatically reduce large document that the printer cannot output

If the printer cannot print the paper size of a document, the printer can automatically reduce
the size when it prints the document.
Check this check box to reduce the size when printing the document.

Fit-to-Page
This function enables you to automatically enlarge or reduce documents to fit to the paper size
loaded in the printer without changing the paper size you specified in your application software.

Scaled
Documents can be enlarged or reduced to be printed.
Specify the size in Printer Paper Size, or enter the scaling ratio in the Scaling box.
Scaling

Specifies an enlargement or reduction ratio for the document you want to print.

Page Layout
Multiple pages of document can be printed on one sheet of paper.
Specify...

Opens the Page Layout Printing dialog box.
Click this button to set details on page layout printing.

Tiling/Poster
This function enables you to enlarge the image data and divide the enlarged data into several
pages to be printed. You can also glue together these sheets of paper to create large printed
matter, such as a poster.
Specify...

Opens the Tiling/Poster Printing dialog box.
Click this button to set details on tiling/poster printing.

Booklet
Booklet printing is the convenient function to create a booklet. Data is printed on both sides of a
sheet of paper. This type of printing ensures that pages can be collated properly, in page number
order, when the printed sheets are folded and stapled at the center.
Specify...

Opens the Booklet Printing dialog box.
Click this button to set details on booklet printing.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the paper.
Check this check box to print the document on both sides.
This function can be used only when Plain Paper is selected for Media Type and one of Normal-size,
Fit-to-Page, Scaled, or Page Layout is selected.
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Stapling Side
Selects the stapling margin position.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
stapling margin position. Check Stapling Side, and select from the list to change it.

Specify Margin...
Opens the Specify Margin dialog box.
You can specify the width of the margin.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

Important
• If the application used to create your document has a similar function, specify the number of copies

with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not need
to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check this check box to group together the pages of each copy when you want to print multiple copies.
Uncheck this check box when you want to print with all pages of the same page number grouped
together.

Important
• When the application software that you used to create the document has the same function, give

priority to the printer driver settings. However, if the print results are not acceptable, specify the
function settings on the application software. When you specify the number of copies and the
printing order with both the application and this printer driver, the number of copies may be
multiplied numbers of the two settings or the specified printing order may not be enabled.

Print Options...
Opens the Print Options dialog box.
Changes detailed printer driver settings for print data that is sent from applications.

Stamp/Background... (Stamp...)
Opens the Stamp/Background (Stamp) dialog box.
The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light
illustration behind the document data.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and

only the stamp function can be used.

Depending on the type of printer driver you are using and the environment, Stamp and Background
may not be available.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.
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Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Pages
Specifies the number of document pages to fit on one sheet.

Page Order
Specifies the document orientation to be printed on a sheet of paper.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Tiling/Poster Printing dialog box

This dialog box allows you to select the size of the image to be printed. You can also make settings for cut
lines and paste markers which are convenient for pasting together the pages into a poster.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings of the Tiling/Poster Printing dialog box.
You can check what the print result will look like.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create a
larger poster.

Print "Cut/Paste" in margins
Specifies whether to print the words "Cut" and "Paste" in the margins. These words serve as
guidelines for pasting together the pages into a poster.
Check this check box to print the words.

Note
• Depending on the type of printer driver you are using and the environment, this function may not

be available.
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Print "Cut/Paste" lines in margins
Specifies whether to print cut lines that serve as guidelines for pasting together the pages into a
poster.
Check this check box to print the cut lines.

Print page range
Specifies the printing range. Select All under normal circumstances.
Select Pages to specify a specific page or range.

Note
• If some of the pages have not been printed well, specify the pages that do not need to be printed

by clicking them in the settings preview of the Page Setup tab. Only the pages shown on the
screen will be printed this time.

Booklet Printing dialog box

This dialog box allows you to set how to bind the document as a booklet. Printing only on one side and
printing a page border, can also be set in this dialog box.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Booklet Printing dialog box.
You can check what the document will look like when printed as a booklet.

Margin for stapling
Specifies which side of the booklet is to be stapled.

Insert blank page
Selects whether to print the document on one side or both sides of the booklet.
Check this check box to print the document on one side of the booklet and select the side to be left
blank from the list.

Margin
Specifies the width of the stapling margin.
The specified width becomes the stapling margin from the center of the sheet.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Specify Margin dialog box

This dialog box allows you to specify the margin width for the side to be stapled. If a document does not fit
on one page, the document is reduced when printed.

Margin
Specifies the width of the stapling margin.
The width of the side specified by Stapling Side becomes the stapling margin.

Print Options dialog box

Makes changes to print data that is sent to the printer.

Depending on the type of printer driver you are using and the environment, this function may not be
available.
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Disable ICM required from the application software
Disables the ICM function required from the application software.
When an application software uses Windows ICM to print data, unexpected colors may be produced
or the printing speed may decrease. If these problems occur, checking this check box may resolve
the problems.

Important
• Uncheck this check box under normal circumstances.
• This function does not work when ICM is selected for Color Correction on the Matching tab of

the Manual Color Adjustment dialog box.

Note
• Disable ICM required from the application software tab cannot be used with the XPS printer

driver.

Disable the color profile setting of the application software
Checking this check box disables information in the color profile that was set on the application
software.
When the information in the color profile set on the application software is output to the printer driver,
the print result may contain unexpected colors. If this happens, checking this check box may resolve
the problem.

Important
• Even when this check box is checked, only some of the information in the color profile is

disabled, and the color profile can still be used for printing.
• Uncheck this check box under normal circumstances.

Ungroup Papers
Sets the display method of Media Type, Page Size, and Printer Paper Size.
To display the items separately, select the check box.
To display the items as a group, clear the check box.

Do not allow application software to compress print data
Compression of the application software print data is prohibited.
If the print result has missing image data or unintended colors, selecting this check box may improve
the condition.

Important
• Uncheck this check box under normal circumstances.

Note
• Do not allow application software to compress print data tab cannot be used with the XPS

printer driver.

Print after creating print data by page
The print data is created in page units, and printing starts after the processing of one page of print
data is complete.
If a printed document contains unintended results such as streaks, selecting this check box may
improve the results.

Important
• Uncheck this check box under normal circumstances.
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Scale images using nearest-neighbor interpolation
When an image is to be enlarged or reduced when printed, the printer uses a simple interpolation
process to enlarge or reduce the image.
If the image data in a printed document is not printed clearly, selecting this check box may improve
the results.

Important
• Uncheck this check box under normal circumstances.

Note
• Scale images using nearest-neighbor interpolation can be used only with the XPS printer

driver.

Prevention of Print Data Loss
You can reduce the size of the print data that was created with the application software and then print
the data.
Depending on the application software being used, the image data may be cut off or may not be
printed properly. In such cases, select On. If you will not be using this function, select Off.

Important
• When using this function, the print quality may drop depending on the print data.

Unit of Print Data Processing
Selects the processing unit of the print data to be sent to the printer.
Select Recommended under normal circumstances.

Important
• A large amount of memory may be used for certain settings.

Do not change the setting if your computer has a small amount of memory.

Note
• Unit of Print Data Processing tab cannot be used with the XPS printer driver.

Stamp/Background (Stamp...) dialog box

The Stamp/Background (Stamp...) dialog box allows you to print a stamp and/or background over or
behind the document pages. In addition to the pre-registered ones, you can register and use your original
stamp or background.

Note
• With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and

only the stamp function can be used.

Stamp
Stamp printing is a function that prints a stamp over a document.
Check this check box and select a title from the list to print a stamp.

Define Stamp...
Opens the Stamp Settings dialog box.
You can check the details of a selected stamp or save a new stamp.
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Place stamp over text
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a stamp over the printed document page. The printed data may be
hidden behind the stamp.
Uncheck this check box to print the document data over the stamp. The printed data will not be
hidden behind the stamp.

Note
• The stamp is given priority because the stamp is printed over the document data in the sections

where the stamp and the document data overlap. When this check box is unchecked, the stamp
is printed behind the document data and may be hidden in the overlapping sections depending
on the application software used.

Print semitransparent stamp
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a semi-transparent stamp over the printed document page.
Uncheck this check box to print the stamp over the document data. The printed data may be hidden
behind the stamp.

Note
• You can use Print semitransparent stamp only with the XPS printer driver.

Stamp first page only
Selects whether the stamp is to be printed on the first page only or on all pages when the document
has two or more pages.
Check the Stamp check box to enable this.
Check this check box to print a stamp on the first page only.

Background
Background printing is a function that allows you to print an illustration or a similar object (bitmap,
etc.) behind the document.
Check this check box to print a background and select a title from the list.

Select Background...
Opens the Background Settings dialog box.
You can register a bitmap as a background, and change layout method and intensity of the selected
background.

Background first page only
Selects whether to print the background on the first page only or print on all pages when the
document has two or more pages.
Check the Background check box to enable this.
Check this check box to print a background on the first page only.

Stamp Tab

The Stamp tab allows you to set the text and bitmap file (.bmp) to be used for a stamp.

Preview Window
Shows the status of the stamp configured in each tab.
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Stamp Type
Specifies the stamp type.
Select Text to create a stamp with characters. Select Bitmap to create with a bitmap file. Select
Date/Time/User Name to display the creation date/time and user name of the printed document.
The setting items in the Stamp tab change depending on the selected type.

When Stamp Type is Text or Date/Time/User Name

Stamp Text
Specifies the stamp text string.
Up to 64 characters can be entered.
For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text.

Important
• Stamp Text appears grayed out and is unavailable if Date/Time/User Name is selected.

TrueType Font
Selects the font for the stamp text string.

Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Outline
Selects a frame that encloses the stamp text string.
If a large font size is selected for Size, characters may extend outside of the stamp border.

Color/Select Color...
Shows the current color for the stamp.
To select a different color, click Select Color... to open the Color dialog box, and select or create a
color you wish to use as a stamp.

When Stamp Type is Bitmap

File
Specifies the name of the bitmap file to be used as the stamp.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file to be used as a stamp.

Size
Adjusts the size of the bitmap file to be used as a stamp.
Moving the slider to the right increases the size, moving the slider to the left decreases the size.

Transparent white area
Specifies whether to make white-filled areas of the bitmap transparent.
Check this check box to make white-filled areas of the bitmap transparent.

Note
• Click Defaults to set Stamp Type to text, Stamp Text to blank, TrueType Font to Arial, Style to

Regular, Size to 36 points, Outline unchecked, and Color to gray with the RGB values (192, 192,
192).
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Placement Tab

The Placement tab allows you to set the position where the stamp is to be printed.

Preview Window
Shows the status of the stamp configured in each tab.

Position
Specifies the stamp position on the page.
Selecting Custom from the list allows you to enter values for the X-Position and Y-Position
coordinates directly.

Orientation
Specifies the angle of rotation for the stamp. The angle can be set by entering the number of
degrees.
Negative values rotate the stamp clockwise.

Note
• Orientation is enabled only when Text or Date/Time/User Name is selected for Stamp Type

on the Stamp tab.

Note
• Click Defaults to set the stamp position to Center and the orientation to 0.

Save settings Tab

The Save settings tab allows you to register a new stamp or delete an unnecessary stamp.

Title
Enter the title to save the stamp you created.
Up to 64 characters can be entered.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Stamps
Shows a list of saved stamp titles.
Specify a title to display the corresponding stamp in Title.

Save/Save overwrite
Saves the stamp.
Enter a title in Title, and then click this button.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps list, and click this button.

Background Tab

The Background tab allows you to select a bitmap file (.bmp) to be used as a background or determine
how to print the selected background.

Preview Window
Shows the status of the bitmap set on the Background tab.
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File
Specifies the name of the bitmap file to be used as the background.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file (.bmp) to be used as the background.

Layout Method
Specifies how the background image is to be placed on the paper.
When Custom is selected, you can set coordinates for X-Position and Y-Position.

Intensity
Adjusts the intensity of the bitmap to be used as a background.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity. To print the background at the original bitmap intensity, move the slider to the rightmost
position.

Note
• Depending on the type of printer driver you are using and the environment, this function may not be

available.
• Click Defaults to set File to blank, Layout Method to Fill page, and the Intensity slider to the

middle.

Save settings Tab

The Save settings tab allows you to register a new background or delete an unnecessary background.

Title
Enter the title to save the background image you specified.
Up to 64 characters can be entered.

Note
• Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Backgrounds
Shows a list of registered background titles.
Specify a title to display the corresponding background in Title.

Save/Save overwrite
Saves the image data as a background.
After inserting the Title, click this button.

Delete
Deletes an unnecessary background.
Specify the title of an unnecessary background from the Backgrounds list, and then click this
button.

206



Maintenance tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.

 Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

 Deep Cleaning
Performs deep cleaning.
Perform deep cleaning when two cleaning attempts do not resolve the print head problem.

Note
• Deep Cleaning consumes a larger amount of ink than Cleaning.

Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Therefore, perform
cleaning only when necessary.

Ink Group
When you click Cleaning or Deep Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.
Click Initial Check Items to display the items that you need to check before you execute cleaning or
deep cleaning.

 Print Head Alignment
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
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Align the print head immediately after installing the print head.
When you click Print Head Alignment, the Start Print Head Alignment dialog box is displayed.

 Nozzle Check
Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly. If the print result for a specific color is
fainted, or if there are any unprinted sections, click Cleaning to clean the print head.
To display a list of items that you should check before printing the nozzle check pattern, click Initial
Check Items.
Print Check Pattern

This function prints a pattern that allows you to check whether the any of the ink nozzles are
clogged.
Click Print Check Pattern. When the confirmation message is displayed, click OK. The Pattern
Check dialog box is then displayed.
Left-side bitmap (good)

The print head nozzles are not clogged.

Right-side bitmap (bad)
The print head nozzles may be clogged.

Exit
Closes the Pattern Check dialog box, and returns to the Maintenance tab.

Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or if a specific color fails to print, even though
all ink levels are sufficiently high.

 Ink Cartridge Settings
Opens the Ink Cartridge Settings dialog box.
Use this function to specify the FINE cartridge you want to use.

 Bottom Plate Cleaning
Performs cleaning of the bottom plate of the printer.
To prevent smudges on the back side of a sheet of paper, perform Bottom Plate Cleaning before you
perform duplex printing.
Also perform Bottom Plate Cleaning if ink smudges caused by something other than print data appear
on the printed page.

 Roller Cleaning
Cleans the paper feed rollers.
Paper feeding may fail if paper dust has stuck to the printer's paper feed rollers. In this case, clean the
paper feed rollers to improve the print result.
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 Power Off
Turns off the printer from the printer driver.
Perform this function to turn off the printer when you cannot press the ON button (POWER button) on
the printer because the printer is out of your reach.
You must press the ON button (POWER button) on the printer to turn the printer on again after clicking
this button. When you use this function, you will not be able to turn the printer on from the printer driver.

 Auto Power
Opens the Auto Power Settings dialog box.
Specify settings for operating the printer power automatically. Perform this function if you want to
change the auto power settings.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an error

message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

 Quiet Settings
Opens the Quiet Settings dialog box.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
This mode comes in handy when the operating noise of the printer becomes a concern, such when
printing at night. Perform this operation when you want to change the quiet mode setting.

Note
• If the printer is off or if communication between the printer and the computer is disabled, an error

message may appear because the computer cannot collect the printer status.

 Custom Settings
Opens the Custom Settings dialog box.
Perform this function to change the settings of this printer.

Note
• If the printer is off or bi-directional communication is disabled, a message may appear because the

computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

View Print History
This function starts the Canon IJ XPS preview, and displays the print history.

Note
• You can use this function only with the XPS printer driver.

View Printer Status
Starts the Canon IJ Status Monitor.
Perform this function when you want to check the printer status and how a print job is proceeding.
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Note
• If you are using the XPS printer driver, the "Canon IJ Status Monitor" becomes the "Canon IJ XPS

Status Monitor".

About
Opens the About dialog box.
The version of the printer driver, plus a copyright notice, can be checked.
In addition, the language to be used can be switched.

Initial Check Items

Check that the printer power is on, and open the cover of the printer.
Check the following items for each ink. Then, if necessary, perform Nozzle Check or Cleaning.

• Check the amount of ink remaining in the cartridge.
• Make sure that you push in the ink cartridge completely until you hear a clicking sound.
• If an orange tape is adhered to the ink cartridge, peel it off completely.

Any remaining tape will hinder ink output.
• Check that the ink cartridges are installed in their correct positions.

Start Print Head Alignment dialog box

This dialog box allows you to adjust the attachment position for the print head, or to print the current
setting value for the print head position.

Note
• For a detailed procedure on head position adjustment, see "Aligning the Print Head Position from

Your Computer."

Align Print Head
Aligns the print head.
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.

Print Alignment Value
Click this button to check the current setting value of the print head position.
Prints the current setting value for the print head position.

Print Head Alignment dialog box

To adjust the print head position, click Align Print Head in the Start Print Head Alignment dialog box,
and perform the operations instructed in the messages. The Print Head Alignment dialog box is then
displayed.
This dialog box allows you to check the printed pattern and adjust the print head position.

Preview Window
Displays the pattern of Print Head Alignment, and checks the position of the selected pattern.
You can also change the setting by clicking the pattern on the screen directly.

Select the Pattern Number
Compare the printed adjustment patterns, and enter the pattern number of the pattern with the
least visible streaks or horizontal stripes into the corresponding box.
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Note
• If you do not know how to analyze the printed pattern, see Aligning the Print Head Position from

Your Computer.

Initial Check Items

Check that the printer power is on, and open the cover of the printer.
Check the following items for each ink. Then, if necessary, perform Nozzle Check or Cleaning.

• Check the amount of ink remaining in the cartridge.
• Make sure that you push in the ink cartridge completely until you hear a clicking sound.
• If an orange tape is adhered to the ink cartridge, peel it off completely.

Any remaining tape will hinder ink output.
• Check that the ink cartridges are installed in their correct positions.

Ink Cartridge Settings dialog box

When you click Ink Cartridge Settings, the Ink Cartridge Settings dialog box is displayed.
This feature enables you to specify the most appropriate FINE cartridge among installed cartridges
according to an intended use.
When one of the FINE cartridges becomes empty and cannot be replaced immediately by a new one, you
can specify the other FINE cartridge that still has ink and continue printing.

Ink Cartridge
Selects the FINE cartridge you use for printing.
Color Only

Uses the color FINE cartridge only.

Black Only
Uses the black FINE cartridge only.

Both Black and Color
Uses the FINE cartridges installed on the printer, which are color and black.

Important
• When a setting other than Plain Paper or Envelope is selected for Media Type on the Main tab,

Black Only is disabled because the machine uses the color FINE cartridge to print documents.
• Do not detach the FINE cartridge that is not in use. Printing cannot be performed while either

FINE cartridge is detached.

Auto Power Settings dialog box

When you click Auto Power, the Auto Power Settings dialog box is displayed.
This dialog box allows you to manage the printer power from the printer driver.

Auto Power On
Selects the auto power-on setting.
Specify Disable to prevent the printer from turning on automatically when print data is sent to it.
Make sure the printer is on and then click OK to change the printer settings.
Specify Enable to turn the printer on automatically when print data is sent to it.
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Auto Power Off
Selects the auto power-off setting.
If a printer driver operation or a printer operation is not performed within the specified time, the printer
turns off.

Quiet Settings dialog box

When you click Quiet Settings, the Quiet Settings dialog box is displayed.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
Select when you wish to reduce the operating noise of the printer at night, etc.
Using this function may lower the print speed.

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified period
of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to the
same time, the quiet mode will not function.

Important
• You can set the quiet mode from the printer or the printer driver.

No matter how you use to set the quiet mode, the mode is applied when you perform operations
from the printer or printing from the computer.

• If you specify a time for Use quiet mode during specified hours, quiet mode is not applied to
operations (direct print, etc.) performed directly from the printer.

Custom Settings dialog box

When you click Custom Settings, the Custom Settings dialog box is displayed.
If necessary, switch between various modes of printer operation.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the document 90 degrees to the left when printing, select the check box.

Ink Drying Wait Time
The printer can pause before printing a subsequent page. Moving the slider to the right increases the
pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries,
increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

About dialog box

When you click About, the About dialog box is displayed.
This dialog box displays the version, copyright, and module list of the printer driver. You can select the
language to be used and switch the language displayed in the setup window.
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Modules
Lists the printer driver modules.

Language
Specifies the language you wish to use in the printer driver setup window.

Important
• If the font for displaying the language of your choice is not installed in your system, the

characters will be garbled.

Related Topics

Cleaning the Print Heads from Your Computer
Aligning the Print Head Position from Your Computer
Use Your Computer to Print a Nozzle Check Pattern
Setting the Ink Cartridge to be Used
Cleaning Inside the Printer
Cleaning the Paper Feed Rollers from Your Computer
Managing the Printer Power
Reducing the Printer Noise
Changing the Printer Operation Mode
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Canon IJ Preview Description

Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.
The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.
When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

File Menu
Selects the print operation.
Start Printing

Ends the Canon IJ Preview and then starts printing the document that is displayed on the preview
screen.
This command has the same function as the Start Printing on the toolbar.

Cancel Printing
Ends the Canon IJ Preview and cancels the printing of the document that is displayed on the
preview screen.
This command has the same function as the Cancel Printing on the toolbar.

Exit
Ends the Canon IJ Preview.

Page Menu
This menu includes the following commands to select page to be displayed.
All of these commands except Page Selection... can also be selected from the toolbar.

Note
• If the pages are being spooled, the last spooled page becomes the last page.
• If the Page Layout setting on the Page Setup tab is specified to Page Layout, Tiling/Poster, or

Booklet, the number of pages is the number of sheets to be used for printing, and not the number
of pages in the original document created with the application software.
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• If duplex printing manually has been set, the front pages which will be printed first are all displayed
together, and then the back pages are displayed.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole

Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
This menu includes the following command:
Displays Print Page Information

Displays print setup information (including printer paper size, media type, and page layout) for each
page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

Help Menu
When you select this menu item, the Help window for Canon IJ Preview is displayed, and you can
check the version and copyright information.
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Start Printing button
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

Cancel Printing button
Ends the Canon IJ Preview, and cancels the printing of the document that is displayed on the preview
screen.
You can click this button while spooling.

Print Page Information Screen
Displays print setup information for each page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

Important
• If the media type and paper source are set from the application software, those settings have

priority and the changed settings may become ineffective.

Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
You can select the media type of the document to be printed.

Paper Source
You can select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Canon IJ XPS Preview Description

Canon IJ XPS Preview is an application software that displays what the print result will look like before a
document is actually printed.
The preview reflects the information which is set within the printer driver and allows you to check the
document layout, print order, and number of pages. The preview also allows you to edit the print document,
edit the print pages, change the print settings, and perform other functions.
When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

Important
• To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile installed

on your computer.

File Menu
Selects print operation and print history settings:
Print

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

This command has the same function as  (Print) on the toolbar and the Print in the print
settings area.

Print All Documents
Prints all documents in the document list and closes the Canon IJ XPS Preview.

Save Print History
Switches whether the documents printed from the Canon IJ XPS Preview are to be saved as print
history entries.

History Entry Limit
Switches the maximum number of print history registrations.
Select 10 Entries, 30 Entries, or 100 Entries.
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Important
• If the limit on the number of registration is exceeded, the print history registrations are deleted

starting from the oldest one.

Add documents from history to the list
Adds the document saved in the print history to the document list.

Exit
Ends the Canon IJ XPS Preview. The documents remaining in the document list will be deleted
from the list.
This command has the same function as the Exit in the print settings area.

Edit Menu
Selects the method for editing multiple documents or pages.
Undo

Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.
This command has the same function as the (Undo) on the toolbar.

Documents
Selects the method for editing print documents.
Combine Documents

Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

This command has the same function as the (Combine Documents) on the toolbar.

Reset Documents
Returns the document selected in the document list to their status before they were added to
the Canon IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

This command has the same function as the (Reset Documents) on the toolbar.

Move Document
Use the following command to change the order of the documents selected in the document
list.

Move to First
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Up One
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Down One
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Move to Last
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.
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Delete Document
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be
selected.

This command has the same function as the (Delete Document) on the toolbar.

Grayscale Printing
Allows you to change the monochrome print settings.
This command has the same functionality as the Grayscale Printing check box in the print
settings area.

Page Layout Printing...
Opens the Page Layout Printing dialog box.
This dialog box allows you to set Page Layout Printing, Pages, Page Order, and Page
Border.

Duplex Printing...
Opens the Duplex Printing dialog box.
This dialog box allows you to set Duplex Printing (Manual), Stapling Side, and Margin.

Copies...
Opens the Copies dialog box.
This dialog box allows you to set Copies, Collate, and Print from Last Page.

Pages
Selects the method for editing print pages.
Delete Page

Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

This command has the same function as the (Delete Page) on the toolbar.

Restore Page
Restores pages that were deleted with the Delete Page function.
To restore pages, you must select the View Deleted Pages check box on the Option menu
and display the deleted pages as thumbnails.

Move Page
Use the following command to change the order of the currently selected pages.

Move to First
Moves the currently selected page to the beginning of the document.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Forward One
Moves the currently selected page one position in front of its current position.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Backward One
Moves the currently selected page one position after its current position.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.
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Move to Last
Moves the currently selected page to the end of the document.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

View Menu
Selects the documents and pages to be displayed.
Documents

Use the following command to select the document to display.
First Document

Displays the first document in the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Previous Document
Displays the document located before the currently displayed document.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Next Document
Displays the document located after the currently displayed document.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Last Document
Displays the last document in the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Pages
Use the following command to select the page to be displayed.

Note
• If the Page Layout setting in the printer driver is specified to Tiling/Poster, or Booklet, the

number of pages is the number of sheets to be used for printing, and not the number of pages
in the original document created with the application software.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.
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Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole

Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
Toggles the show / hide status of the following information.
View Thumbnails

Reduces all pages in the document selected in the document list and displays them at the bottom
of the preview window.

This command has the same function as the (View Thumbnails) on the toolbar.

View Document List
Displays the print document list at the top of the preview window.

View Print Settings Area
Displays the print settings area at the right side of the preview window.

View Deleted Pages
When the thumbnails are displayed, this function displays pages that were deleted with the Delete
Page function.
To check deleted pages, you must first select the View Thumbnails check box.

Keep printed documents on the list
Leaves the printed document in the document list.

Print Settings Displayed at Startup
Switches the tab of the print settings area to be displayed when the Canon IJ XPS Preview is
started.
Select Page Information, Layout, or Manual Color Adjustment.

Help Menu
When you select this menu item, the Help window for Canon IJ XPS Preview is displayed, and you can
check the version and copyright information.

(Print)
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.
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(Combine Documents)
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

(Delete Document)
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be selected.

(Reset Documents)
Returns the document selected in the document list to their status before they were added to the Canon
IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

(View Thumbnails)
Reduces all pages in the document selected in the document list and displays them at the bottom of the
preview window.
To hide the print pages, click View Thumbnails again.

(Move to First)
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

(Move Up One)
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

(Move Down One)
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

(Move to Last)
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

(Undo)
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.

(Delete Page)
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

Document list
Displays the list of the print documents.
The document selected in the document list becomes the target for preview display and editing.
Document Name

Displays the name of the print document.
If you click the name of the selected print document, a text box is displayed, and you can rename
the document to any name.
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Pages
Displays the number of pages in the print document.

Important
• The number displayed in Pages and the output page count are different.
• To check the output page count, check the status bar at the bottom of the preview window.

Status
Displays the status of the print documents.
Documents that are undergoing data processing are displayed as Processing data.

Important
• Documents showing Processing data cannot be printed or edited.

Wait until the data processing ends.

Print Settings Area Screen
Allows you to check and change the print settings of the documents selected in the document list.
Print Settings Area is displayed on the right side of the preview window.
Page Information tab

The print settings are displayed for each page.
You can change the media type and paper source settings.
Printer Paper Size

Displays the paper size of the document to be printed.

Media Type
Allows you to select the media type of the document to be printed.

Paper Source
Allows you to select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.

Layout tab
You can specify settings for page layout printing.
To apply the specified settings, click Apply.
If the page layout print settings cannot be changed for the print document, the individual items are
grayed out and cannot be selected.

Manual Color Adjustment tab
This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast options.
Cyan/Magenta/Yellow

Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a
color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document.
Use your application software if you want to change the total color balance significantly. Use
the printer driver only if you want to adjust the color balance slightly.

223



Important
• When Grayscale Printing is checked, Cyan, Magenta, and Yellow appear grayed out

and are unavailable.

Brightness
Selects the brightness of your print.
Pure white and black will not change, but colors between white and black will change.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left
decreases the intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on this tab to their default values (factory settings).

Grayscale Printing
Allows you to change the monochrome print settings.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
If the duplex print settings cannot be changed for the print document, this item is grayed out and is
unavailable.

Important
• When you select Booklet for Page Layout, Duplex Printing (Manual) of the print settings

area will be set automatically. In this case, Duplex Printing (Manual) is grayed out and is
unavailable.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
If the numbers of copies cannot be changed for the print document, this item is grayed out and is
unavailable.

Exit
Ends the Canon IJ XPS Preview.
The documents remaining in the document list will be deleted from the list.

Print
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

224



Canon IJ Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.

Canon IJ Status Monitor Features

The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

You can check the ink status.
This function displays graphics showing the FINE cartridge type and the estimated ink levels.
Icons and messages are displayed when ink is running low (ink level warning).

Canon IJ Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with graphics and messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon IJ Status Monitor shows an icon when a warning or error occurs to the printer.

 : Indicates that a warning (operator call error) has occurred or the printer is working.
 : There has been an error which requires a service.

FINE cartridge
Canon IJ Status Monitor shows an icon when a low ink warning or a no ink error occurs.
In addition, this function displays graphics showing the estimated ink levels of the FINE cartridge.
In this case, click the graphics to open the Ink Details dialog box. You can check the detail
information such as the remaining ink level and the FINE cartridge types for your printer.

Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.
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Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print
queue.

Cancel Printing
Cancels the current print job.

Important
• The Cancel Printing button is enabled only while print data is being sent to the printer.

Once the print data has been sent, the button is grayed out and becomes unavailable.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon IJ
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job

Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Warning Automatically
When a Low Ink Warning Occurs

Starts the Canon IJ Status Monitor window automatically and displays it in front of the
other windows when a low ink warning occurs.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Ink Details Menu
Select this menu to display the Ink Details dialog box. Check the detail information such as the
remaining ink level and the FINE cartridge types for your printer.
Ink Details dialog box

This function displays graphics and messages showing the FINE cartridge type and the
estimated ink levels.
Ink Information (displayed at left)

Shows the FINE cartridge types with graphics.
If a warning or error related to the remaining ink level occurs, the printer driver displays
an icon to let you know.
If the icon is displayed, operate the printer according to the instructions displayed on the
screen.

Message (displayed at right)
Shows information such as the ink status and ink colors with sentences.

Ink Model Number
Shows the FINE cartridge types for your printer.

Close
Closes the Ink Details dialog box to return to Canon IJ Status Monitor.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and
you can check the version and copyright information.
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Updating the Printer Driver

Obtaining the Latest Printer Driver
Deleting the Unnecessary Printer Driver
Before Installing the Printer Driver
Installing the Printer Driver
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be solved.

You can check the version of the printer driver by clicking the About button on the Maintenance tab.

You can access our website and download the latest printer driver for your model.

Important
• You can download the printer driver for free, but any Internet access charges incurred are your

responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Before Installing the Printer Driver
Installing the Printer Driver
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Deleting the Unnecessary Printer Driver

The printer driver which you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

1. Start the uninstaller

• If you are using Windows 8, from the Desktop charms, select Settings -> Control Panel ->
Programs -> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows 7 or Windows Vista, select Start menu -> Control Panel -> Programs -
> Programs and Features.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Uninstall.

• If you are using Windows XP, select Start menu -> Control Panel -> Add or Remove Programs.
From the program list, select "XXX Printer Driver" (where "XXX" is your model name) and then
click Remove.

The confirmation window for uninstalling the model appears.

Important
• In Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box may appear when

starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the printer driver is complete.

Important
• Printer driver and XPS printer driver will be deleted when you uninstall the Printer Driver.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the printer driver. You should also
refer to this section if the printer driver cannot be installed.

Checking the Printer Status

• Confirm that the USB port of this printer and the computer are firmly connected with the USB cable.
• Turn off the printer.

Checking the Personal Computer Settings

• Terminate all running applications.
• In Windows 8, Windows 7, or Windows Vista, log on as a user who has the administrator account.

In Windows XP, log on as the computer administrator.

Important
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Obtaining the Latest Printer Driver
Installing the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest printer driver and XPS printer
driver for your model.

The procedure for installing the downloaded printer driver is as follows:

1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

Important
• In Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box may appear when

starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the printer driver

Take the appropriate action as described on the screen.

Note
• To use a network printer from a client printer, you must manually select the connection destination

from the client.
To manually select a connection destination, click Cancel in the Connect Cable window. When
the confirmation message appears, click Yes.
In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

4. Complete the installation

Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

Important
• You can install the XPS printer driver with the same procedure for installing the printer driver. However,

when installing the XPS printer driver, first complete installation of the printer driver.
• You can download the printer driver and XPS printer driver for free, but any Internet access charges

incurred are your responsibility.
• Before installing the latest printer driver, delete the previously installed version.

Related Topics

Obtaining the Latest Printer Driver
Deleting the Unnecessary Printer Driver
Before Installing the Printer Driver
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Sharing the Printer on a Network

When multiple computers are being used in the network environment, you can share the printer connected
to one computer with the other computers.
The Windows versions of the computers connected to the network do not necessarily have to be the same.

• Settings on Print Server

This section describes the procedure for setting a computer that connects with this printer directly
through a USB cable.

• Settings on Client PC

This section describes the procedure for setting a computer that uses this printer though a network.
When you execute print, the data is sent to the printer through the print server system.

Important
• In case an error occurred when a document is printed by the client system to a shared printer, the error

message of Canon IJ Status Monitor will be displayed both on the client system and the print server
system. For regular printing, Canon IJ Status Monitor will be displayed only on the client system.

Note
• You must install a print driver in the print server and in each client.

Related Topic

Restrictions on Printer Sharing
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Settings on Print Server

When you use the printer on a network, set up the printer driver for sharing on the print server system.

The procedure for setting up the print server systems is as follows:

1. Install the printer driver on the print server system

2. Select as described below:

• If you are using Windows 8, from the Desktop charms, select Settings -> Control Panel ->
Hardware and Sound -> Devices and Printers.

• If you are using Windows 7, select the Start menu -> Devices and Printers.
• If you are using Windows Vista select the Start menu -> Control Panel -> Hardware and Sound -

> Printers.
• If you are using Windows XP, select the start menu -> Control Panel -> Printers and Other

Hardware -> Printers and Faxes.

The Devices and Printers window (Windows 8, Windows 7), Printers window (Windows Vista) or
Printers and Faxes window (Windows XP) is displayed.

3. Click the icon for the model name of printer to be shared

• If you are using Windows 8, press the Alt key, and from the displayed File menu, click Printer
properties -> "Your model name" -> Sharing tab.

• If you are using Windows 7, press the Alt key on your keyboard and then select Printer properties
-> Sharing tab from the displayed File menu.

• If you are using Windows Vista, press the Alt key on your keyboard and then select Run as
administrator -> Sharing... from the displayed File menu.

• If you are using Windows XP, select Sharing... from the File menu.

Important
• In Windows 8, Windows 7, or Windows Vista, a confirmation/warning dialog box may appear when

starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

Note
• Windows XP may display a message recommending the user to use the Network Setup Wizard to

set up sharing.
When this message appears, choose not to use the wizard and then set up sharing.

4. Set sharing

Select Share this printer on the Sharing tab to set a shared name if necessary, and click OK.

The setup on the print server system is complete. Next, set up the client systems.
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Settings on Client PC

After setting up the print server system, set up the client system.

The procedure for setting up the client systems is as follows:

If you are using Windows 8, Windows 7, or Windows Vista

1. Install the printer driver on the client systems

Note
• You must manually select the connection destination on the client computer.

During installation, click Cancel in the Connect Cable window. When the confirmation
message appears, click Yes.
In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

2. Start the wizard

• If you are using Windows 8, from the Desktop charms, select Settings -> Control Panel ->
Hardware and Sound -> Devices and Printers -> Add a printer.

• If you are using Windows 7, select the Start menu -> Devices and Printers -> Add a printer.
• If you are using Windows Vista, select the Start menu -> Network -> Add Printer.

The Add Printer window appears.

3. Add a printer

Select Add a network, wireless or Bluetooth printer, and click the icon for the printer that you have
configured on the print server system to be shared, and then click Next.

Note
• If the icon for the printer is not displayed, check that the printer is actually connected to the print

server.
• It may take some time for the icon for the printer to appear.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.

• If you are using Windows 8 or Windows 7, the icon for the shared printer will be created in the
Devices and Printers window.

• If you are using Windows Vista, the icon for the shared printer will be created in the Printers
window.

The setup on the client systems is complete. You can now share the printer in the network.

If you are using Windows XP

1. Install the printer driver on the client systems

For installation instructions, see "Installing the Printer Driver."
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Note
• You must manually select the connection destination on the client computer.

During installation, click Cancel in the Connect Cable window. When the confirmation
message appears, click Yes.
In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

2. Start the wizard

Select the start menu -> Control Panel -> Printers and Other Hardware -> Printers and Faxes ->
Add a printer.

When Welcome to the Add Printer Wizard screen appears, click Next.

3. Add a printer

Select A network printer, or a printer attached to another computer, then click Next.

On the Specify a Printer window, click Next and then search for the print server system.

Click the icon for the printer that you have configured on the print server system to be shared, and
then click Next.

Note
• If the icon for the printer is not displayed, check that the printer is actually connected to the print

server.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.
The icon for the shared printer will be created in the Printers and Faxes window.

The setup on the client systems is complete. You can now share the printer in the network.
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Restrictions on Printer Sharing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when
reading this information.

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

When You Are Sharing a Printer in a Network

• A print completion message may be displayed. To disable the message from being displayed, follow
the procedure below.

◦ If you are using Windows 8:

In the Devices and Printers window of the client, select the printer from Printers, and click Print
server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows 7:

In the Devices and Printers window of the client, select the printer from Printers and Faxes, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows Vista:

Press the Alt key from the Printers window on the client system. Open Run as administrator ->
Server Properties... from the displayed File menu.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

◦ If you are using Windows XP:

Open Server Properties from the File menu of the Printers and Faxes window on the print
server system.
Uncheck Notify when remote documents are printed on the Advanced tab, and then restart
the computer.

• The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties (to display the properties when using Windows 8 or
Windows 7, press the Alt key, and select Printer properties from the displayed File menu) and then
clicks OK with the Enable bidirectional support check box cleared on the Ports tab, the
bidirectional communication function of the print server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

• When you print from a client system, you cannot use Canon IJ Preview.
• When the functions on the Maintenance tab cannot be set properly from a client system, they may be

grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.
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When the Same Printer Driver is Installed in the Print Server System and the
Client System as the Local Printer

• The net crawl function may automatically create a network printer icon on the client system.
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Troubleshooting

The Printer Cannot Be Powered On

Printing Does Not Start

Paper Does Not Feed Properly/"No Paper" Error Occurs

Print Results Not Satisfactory

Ink Is Not Ejected

Paper Jams

If an Error Occurs

Search Each Function

Problems with Printing

Problems with Printing Quality

Problems with the Printer

Problems with Installation/Downloading

About Errors/Messages Displayed

If You Cannot Resolve the Problem
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Problems with Printing

Printing Does Not Start

Paper Jams

Paper Does Not Feed Properly/"No Paper" Error Occurs

Printing Stops Before It Is Completed
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Printing Does Not Start

Check1  Make sure that the power plug is securely plugged in, then press the ON/
RESUME button to turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit.

Note
• When printing large data such as a photo or graphics, it may take longer to start printing. While the

POWER lamp is flashing, the computer is processing data and sending it to the printer. Wait until printing
starts.

Check2  Make sure that the USB cable is securely plugged in to the printer and the
computer.

When the printer is connected to your computer with a USB cable, check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device. Consult
the reseller of the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.

Check3  If there are any unnecessary print jobs, delete them.

Deleting the Undesired Print Job

Check4  Make sure that your printer's name is selected in the Print dialog box.

The printer will not print properly if you are using a printer driver for a different printer.

Make sure that your printer's name is selected in the Print dialog box.

Note
• To make the printer the one selected by default, select Set as Default Printer.

Check5  Configure the printer port appropriately.

Make sure that the printer port is configured appropriately.

1. Log on as a user account with administrator privilege.

2. Select items as shown below.

• In Windows 8, select Control Panel from the Settings charm on Desktop > Hardware and Sound >
Devices and Printers.

• In Windows 7, select Devices and Printers from the Start menu.

• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open the properties of the printer driver for the printer.

• In Windows 8 or Windows 7, right-click the "Canon XXX" icon (where "XXX" is your printer's name),
then select Printer properties.
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• In Windows Vista or Windows XP, right-click the "Canon XXX" icon (where "XXX" is your printer's
name), then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX" appearing in the Printer
column is selected for Print to the following port(s).

• If the setting is incorrect:

Reinstall the printer driver with the Setup CD-ROM or install it from our website.

• Printing does not start even though the printer is connected to the computer using a USB cable and the
port named "USBnnn" is selected:

In Windows 8, select My Printer on the Start screen to start My Printer. If My Printer is not displayed
on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to set
the correct printer port, then select your printer's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon Utilities,
Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow the on-
screen instructions to set the correct printer port, then select your printer's name.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.

Check6  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Check7  Restart your computer.
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Paper Jams

When paper is jammed, the Alarm lamp flashes orange and a troubleshooting message is displayed on the
computer screen automatically. Take the appropriate action described in the message.

For details on how to remove the jammed paper, refer to Support Code List (When Paper Is Jammed).

Note
• You can confirm the actions against errors with Support Codes on your computer by searching a

Support Code.

Click Here to Search
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Paper Does Not Feed Properly/"No Paper" Error Occurs

Check1  Make sure that paper is loaded.

Loading Paper

Check2  Make sure of the following when you load paper.

• When loading two or more sheets of paper, align the edges of the sheets before loading.

• When loading two or more sheets of paper, make sure that the paper stack does not exceed the paper load
limit.

However, proper feeding of paper may not be possible at this maximum capacity depending on the type of
paper or environmental conditions (either very high or low temperature and humidity). In such cases, reduce
the sheets of paper you load at a time to less than half of the paper load limit.

• Always load the paper in portrait orientation, regardless of the printing orientation.

• When you load the paper, load the paper with the print side facing UP. Align the paper stack against the
right side of the rear tray and slide the paper guide so that it just touches the left edge of the stack.

Loading Paper

Check3  Check to see if the paper you are printing on is not too thick or curled.

Media Types You Cannot Use

Check4  Make sure of the following when you load envelopes.

When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

Check5  Confirm that the media type and the paper size settings correspond with the
loaded paper.

Check6  Make sure that there are not any foreign objects in the rear tray.

If the paper tears in the rear tray, see Paper Jams to remove it.

If there are any foreign objects in the rear tray, be sure to turn off the printer, unplug it from the power supply,
then remove the foreign object.

243



Check7  Clean the paper feed roller.

Cleaning the Paper Feed Rollers from Your Computer

Note
• Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.
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Printing Stops Before It Is Completed

Check1  Is the paper loaded?

Make sure that paper is loaded.

If the printer has run out of paper, load paper.

Check2  Do the printing documents have lots of photographs or illustrations?

As printing large data such as photos or graphics takes time for the printer and the computer to process, the
printer may appear to have stopped operating.

In addition, when printing data that uses a large amount of ink continuously on plain paper, the printer may
pause temporarily. In either case, wait until the process is complete.

Note
• If you are printing a document with a large printing area or printing multiple copies of a document, printing

may pause to allow the ink to dry.

Check3  Has the printer been printing continuously for a long period?

If the printer has been printing continuously for a long time, the print head or other parts around it may overheat.
The printer may stop printing at a line break for a period of time and then resume printing.

In this case, wait for a while without operation. If the printing still does not resume, interrupt your print session at
a convenient time and turn the printer off for at least 15 minutes.

Caution
• The print head and the surrounding area can become extremely hot inside the printer. Never touch the

print head or nearby components.
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Problems with Printing Quality

Print Results Not Satisfactory

Ink Is Not Ejected
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Print Results Not Satisfactory

If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the
paper and print quality settings first.

Check1  Do the page size and media type settings match the size and type of the loaded
paper?

When these settings are incorrect, you cannot obtain a proper print result.

If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality of the
printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

Confirm the page size and media type settings using the printer driver.

Printing with Easy Setup

Check2  Make sure that the appropriate print quality is selected using the printer driver.

Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven colors,
increase the print quality setting and try printing again.

You can confirm the print quality setting using the printer driver.

Changing the Print Quality and Correcting Image Data

Check3  If the problem is not resolved, there may be other causes.

See also the sections below:

Cannot Print to End of Job

No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

Colors Are Unclear

Lines Are Misaligned

Line Does Not Print or Prints Partially

Image Does Not Print or Prints Partially

Printed Paper Curls or Has Ink Blots

Paper Is Smudged/Printed Surface Is Scratched

Back of the Paper Is Smudged

Colors Are Uneven or Streaked

If the Printed Paper Has Been Discolored

Colors may fade with time if the printed paper is left for a long period of time.

After printing, dry the paper sufficiently, avoid high temperatures, high humidity, and direct sunlight, and
store or display indoors at room temperature and normal humidity.

To avoid direct exposure to air, it is recommended that you store the paper in an album, plastic folder,
photo frame, etc.
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Cannot Print to End of Job

Check1  Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.

Check3  Is the space of your computer's hard disk sufficient?

Delete unnecessary files to free disk space.
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White
Streaks

 No Printing Results

 Printing Is Blurred

 Colors Are Wrong

 White Streaks
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Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.

Check3  When a FINE cartridge runs out of ink, replace it with a new one.

Check4  When using paper with one printable surface, make sure that the paper is
loaded with the printable side facing up.

Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

Load paper with the printable side facing up.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.

Check5  Is the FINE cartridge installed properly?

If the FINE cartridge is not installed securely, ink may not be ejected correctly.

Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push the FINE cartridge until it clicks into place.

After confirming that the FINE cartridge is installed properly, close the cover.
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Colors Are Unclear

Check1  Is the Nozzle Check Pattern printed properly?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.

Check2  When a FINE cartridge runs out of ink, replace it with a new one.

Check3  Is the FINE cartridge installed properly?

If the FINE cartridge is not installed securely, ink may not be ejected correctly.

Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push the FINE cartridge until it clicks into place.

After confirming that the FINE cartridge is installed properly, close the cover.

Note
• Printed colors may not match screen colors due to basic differences in the methods used to produce

colors. Color control settings and environmental differences can also affect how colors appear on the
screen. Therefore, colors of printing results may be different from those on the screen.
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Lines Are Misaligned

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Perform Print Head Alignment.

If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

Aligning the Print Head Position from Your Computer

Check3  Increase the print quality and try printing again.

Increasing the print quality in the printer driver may improve the print result.
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Line Does Not Print or Prints Partially

Check1  Is the Page Layout Printing performed or the Binding margin function used?

When the Page Layout Printing or Binding margin function is being used, thin lines may not be printed. Try
thickening the lines in the document.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Image Does Not Print or Prints Partially

Check1  Select the setting not to compress the printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on the Page Setup sheet on the printer driver. Select the Do not allow application
software to compress print data check box, then click OK.

* Deselect the check box after printing is complete.

Check2  Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet on the printer driver. Then, set Prevention of Print Data Loss in
the displayed dialog to On.

* When On is selected for Prevention of Print Data Loss, print quality may be reduced.
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Printed Paper Curls or Has Ink Blots

 Printed Paper Has Ink Blots

 Printed Paper Curls

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  If the intensity is set high, reduce the intensity setting and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

You can confirm the intensity using the printer driver.

Adjusting Intensity

Check3  Is Photo Paper used for printing photographs?

When printing data with high color saturation such as photographs or images in deep color, we recommend
using Photo Paper Plus Glossy II or other Canon speciality paper.

Media Types You Can Use
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Paper Is Smudged/Printed Surface Is Scratched

 Paper Is Smudged

The Edges of Paper Are Smudged Printed Surface Is Smudged

 Printed Surface Is Scratched

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Is the appropriate type of paper used? Check the followings:

Check to see if the paper you are printing on is suitable for your printing purpose.

Media Types You Can Use

Check3  Load the paper after correcting its curl.

We recommend putting unused paper back into the package and keeping it on a level surface.

• For Plain Paper

Turn the paper over and reload it to print on the other side.

Leaving the paper loaded on the rear tray for a long time may cause the paper to curl. In this case, load the
paper with the other side facing up. It may resolve the problem.

• For Other Paper

If the curl on the four corners of the paper is more than 0.1 inch / 3 mm (A) in height, the paper may be
smudged or may not be fed properly. In such cases, follow the procedure described below to correct the
paper curl.

1. Roll up the paper in the opposite direction to the paper curl as shown below.
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2. Check that the paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

Note
• Depending on the media type, the paper may be smudged or may not be fed properly even if it is not

curled inward. In such cases, follow the procedure described below to curl the paper outward within 0.1
inch / 3 mm (B) in height before printing. This may improve the print result.

(C) Printing side

We recommend printing paper that has been curled outward one sheet at a time.

Check4  If the intensity is set high, reduce the intensity setting and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink and become
wavy, causing paper abrasion.

Reduce the intensity setting in the printer driver and try printing again.

1. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

2. On the Main sheet, select Manual for Color/Intensity, and then click Set....

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.

Check5  Is printing performed beyond the recommended printing area?

If you are printing beyond the recommended printing area of your printing paper, the lower edge of the paper
may become stained with ink.

Resize your original document in your application software.

Printing Area

Check6  Is the paper feed roller dirty?

Clean the paper feed roller.

Cleaning the Paper Feed Rollers from Your Computer

Note
• Cleaning the paper feed roller will wear the roller, so perform this procedure only when necessary.

Check7  Is the inside of the printer dirty?
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When performing duplex printing, the inside of the printer may become stained with ink, causing the printout to
become smudged.

Perform the Bottom Plate Cleaning to clean the inside of the printer.

Cleaning Inside the Printer

Note
• To prevent the inside of the printer from stains, set the paper size correctly.

Check8  Set the time to dry the printed surface longer.

Doing so gives the printed surface enough time to dry so that paper smudged and scratched are prevented.

1. Make sure that the printer is turned on.

2. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

3. Click the Maintenance tab and then Custom Settings.

4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click OK.

5. Confirm the message and click OK.
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Back of the Paper Is Smudged

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Perform the Bottom Plate Cleaning to clean the inside of the printer.

Cleaning Inside the Printer

Note
• When performing duplex printing or too much printing, the inside may become stained with ink.
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Colors Are Uneven or Streaked

 Colors Are Uneven

 Colors Are Streaked

Check1  Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check2  Print the Nozzle Check Pattern and perform any necessary maintenance
operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.

Check3  Perform Print Head Alignment.
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Aligning the Print Head Position from Your Computer
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Ink Is Not Ejected

Check1  When a FINE cartridge runs out of ink, replace it with a new one.

Check2  Is the FINE cartridge installed properly?

If the FINE cartridge is not installed securely, ink may not be ejected correctly.

Retract the output tray extension and the paper output tray, open the cover, then remove the FINE cartridges.

Then install the FINE cartridges again. Push the FINE cartridge until it clicks into place.

After confirming that the FINE cartridge is installed properly, close the cover.

Check3  Are the print head nozzles clogged?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head nozzles.

Refer to When Printing Becomes Faint or Colors Are Incorrect for the Nozzle Check Pattern printing, Print Head
Cleaning, and Print Head Deep Cleaning.

• If the Nozzle Check Pattern is not printed correctly:

After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the pattern.

• If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printer and
perform another Print Head Deep Cleaning after 24 hours.

• If the problem is not resolved after performing the Print Head Deep Cleaning twice:

Ink may have run out. Replace the FINE cartridge.
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Problems with the Printer

The Printer Cannot Be Powered On

The Printer Turns Off Unintentionally

Cannot Connect to Computer Properly

FINE Cartridge Holder Does Not Move to the Position for Replacing

Printer Status Monitor Is Not Displayed
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The Printer Cannot Be Powered On

Check1  Press the ON/RESUME button.

Check2  Make sure that the power plug is securely plugged into the power cord
connector of the printer, then turn it back on.

Check3  Unplug the printer from the power supply, then plug the printer back in and turn
the printer back on after leaving it for at least 2 minutes.

If the problem is not resolved, contact the service center.
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The Printer Turns Off Unintentionally

Check  Deactivate the setting to turn the unit off automatically.

The printer turns off automatically according to the elapsed time you specified if you activate the setting to turn
the unit off automatically.

If you do not want the printer to turn off automatically, open the printer driver setup window and in Auto Power
under the Maintenance sheet, select Disable for Auto Power Off.
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Cannot Connect to Computer Properly

Printing Speed Is Slow/Hi-Speed USB Connection Does Not Work/"This
device can perform faster" Message Is Displayed

If your system environment is not fully compatible with Hi-Speed USB, the printer will operate at a lower
speed provided under USB 1.1. In this case, the printer operates properly but printing speed may slow
down due to communication speed.

Check  Check the following to make sure that your system environment supports Hi-
Speed USB connection.

• Does the USB port on your computer support Hi-Speed USB connection?

• Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is no longer than around
10 feet / 3 meters.

• Does the operating system of your computer support Hi-Speed USB connection?

Obtain and install the latest update for your computer.

• Does the Hi-Speed USB driver operate properly?

Obtain the latest version of the Hi-Speed USB driver compatible with your hardware and reinstall it on
your computer.

Important
• For details on Hi-Speed USB of your system environment, contact the manufacturer of your computer,

USB cable, or USB hub.
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FINE Cartridge Holder Does Not Move to the Position for Replacing

Check1  Is the POWER lamp off?

Check if the POWER lamp is lit.

The FINE cartridge holder will not move unless the power is on. If the POWER lamp is off, close the cover and
turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit, and then open the cover again.

Check2  Is the Alarm lamp flashing?

Close the cover, confirm the number of times the Alarm lamp is flashing, take the appropriate action to resolve
the error, and then reopen it. For details on how to resolve the error, see If an Error Occurs.

Check3  Has the cover been left open for 10 minutes or longer?

If the cover is left open for more than 10 minutes, the FINE cartridge holder moves to the position to protect it to
prevent the print head from drying out. Close and reopen the cover to return the FINE cartridge holder to the
position for replacing.

Check4  Has the printer been printing continuously for a long period?

If the printer has been printing continuously for a long time, the FINE cartridge holder may not move to the
position for replacing since the print head may overheat.

Note
• Do not open the cover while printing is in progress; otherwise, an error occurs
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Printer Status Monitor Is Not Displayed

Check  Is the printer status monitor enabled?

Make sure that Enable Status Monitor is selected on the Option menu of the printer status monitor.

1. Open the printer driver setup window.

How to Open the Printer Driver Setup Window

2. On the Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on the Option menu if it is not selected.
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Problems with Installation/Downloading

Cannot Install the Printer Driver

Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu Does Not
Appear
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Cannot Install the Printer Driver

• If the installation does not start even after the Setup CD-ROM is inserted into your computer's
disc drive:

Start the installation following the procedure below.

1. Select items as shown below.

◦ In Windows 8, select the Explorer icon in Taskbar on Desktop, then select Computer from
the list on the left.

◦ In Windows 7 or Windows Vista, click Start then Computer.

◦ In Windows XP, click Start then My Computer.

2. Double-click the  CD-ROM icon on the displayed window.

If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

If you cannot install the printer driver with the Setup CD-ROM, install it from our website.

Note
• If the CD-ROM icon is not displayed, try the following:

• Remove the CD-ROM from your computer, then insert it again.

• Restart your computer.

If the icon is not yet displayed, try different discs and see if they are displayed. If other discs are
displayed, there is a problem with the Setup CD-ROM. In this case, contact the service center.

• If you are unable to proceed beyond the Printer Connection screen:
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Note
• The printer is not detected. Check the connection. may be displayed depending on the

computer you use.

Check1  Make sure that the USB cable is securely plugged in to the printer and the
computer.

Check2  Follow the procedure below to connect the printer and the computer again.

1. Turn the printer off.

2. Unplug the USB cable from the printer and the computer, then connect it again.

3. Turn the printer on.

Check3  If you cannot resolve the problem, follow the procedure below to reinstall the
printer driver.

1. Click Cancel.

2. Click Start Over on the Installation Failure screen.

3. Click Exit on the "PIXMA XXX" screen (where "XXX" is your printer's name), then remove the CD-
ROM.

4. Turn the printer off.

5. Restart the computer.

6. Make sure that you have no application software running.

7. Insert the CD-ROM again, then install the printer driver.

• In other cases:

Reinstall the printer driver.

If the driver was not installed correctly, uninstall the printer driver, restart your computer, then reinstall
the driver.

Deleting the Unnecessary Printer Driver

If you reinstall the printer driver, install the printer driver with the Setup CD-ROM or install it from our
website.

Note
• If the installer was forced to be terminated due to a Windows error, the system may be in an

unstable condition and you may not be able to install the driver. Restart your computer before
reinstalling.
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Easy-WebPrint EX Does Not Start Up or Easy-WebPrint EX Menu
Does Not Appear

If Easy-WebPrint EX does not start up or its menu does not appear on Internet Explorer, confirm the
following.

Check1  Is Canon Easy-WebPrint EX displayed on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not displayed, Easy-WebPrint EX is not installed on your computer. Install the
latest Easy-WebPrint EX onto your computer from our website.

Note
• If Easy-WebPrint EX is not installed on your computer, a message asking you to install it may be displayed

on the notification area on the desktop. Click the message, then follow the instructions on the computer
screen to install Easy-WebPrint EX.

• While the installation or download Easy-WebPrint EX is in progress, it is necessary to access the Internet.

Check2  Is Canon Easy-WebPrint EX selected on the Toolbars menu in the Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not selected, Easy-WebPrint EX is disabled. Select Canon Easy-WebPrint EX
to enable it.
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About Errors/Messages Displayed

If an Error Occurs

A Message Is Displayed
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If an Error Occurs

When an error occurs in printing such as the printer is out of paper or paper is jammed, a troubleshooting
message is displayed automatically. Take the appropriate action described in the message.

When an error occurs, the Alarm lamp flashes orange and a Support Code (error number) is displayed on
the computer screen. For some errors, the POWER lamp and the Alarm lamp flashes alternately. Check the
status of the lamps and the message, then take the appropriate action to resolve the error.

Support Code Corresponding to the Number of Flashes of the Alarm Lamp

Example of 2 times flashing:

(A) Flashes

(B) Goes off

Number of flashes Cause Support Code

2 flashes There is no paper in the rear tray. 1000

3 flashes The cover is opened while printing is in progress. 1203

Paper is jammed in the paper output slot or in the rear tray. 1300

4 flashes The FINE cartridge is not installed properly. 1687

5 flashes The FINE cartridge is not installed. 1401

The FINE cartridge cannot be recognized. 1403

Appropriate FINE cartridge is not installed. 1485

8 flashes The ink absorber is almost full. 1700, 1701

9 flashes The protective material for the FINE cartridge holder or the tape may remain
attached to the holder.

1890

11 flashes Paper type and paper size settings are incorrect. 4102

12 flashes You cannot print the contents on CREATIVE PARK PREMIUM. 4100

13 flashes The ink may have run out. 1686

14 flashes The ink cartridge cannot be recognized. 1684

15 flashes The FINE cartridge cannot be recognized. 1682

16 flashes The ink has run out. 1688
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Support Code Corresponding to the Number of Alternate Flashes of the
POWER Lamp and the Alarm Lamp

Example of 2 times flashing:

(A) Flashes

(B) Goes off

Number of flashes Cause Support Code

2 flashes Printer error has occurred. 5100

7 flashes Printer error has occurred. 5B00, 5B01

10 flashes An error requiring you to contact the service
center has occurred.

B200, B201

Other cases than above Printer error has occurred. 5200, 5400, 6000, 6800, 6801, 6930, 6931,
6932, 6933, 6940, 6941, 6942, 6943, 6944,
6945, 6946

• When a Support Code and a message are displayed on the computer screen:

Note
• You can confirm the actions against errors with Support Codes on your computer by searching a

Support Code.

Click Here to Search
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For details on how to resolve errors without Support Codes, see A Message Is Displayed.
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A Message Is Displayed

This section describes some of the errors or messages.

Note
• A Support Code (error number) is displayed on the computer for some error or message. For details on

errors with Support Codes, refer to Support Code List.

Error Regarding the Power Cord Being Unplugged Is Displayed

Writing Error/Output Error/Communication Error

Other Error Messages

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

Error Regarding the Power Cord Being Unplugged Is Displayed

The power cord may have been unplugged while the printer was still on.

Check the error message that appears on the computer, then click OK.

The printer starts printing.

See Notice for Unplugging the Power Cord for unplugging the power cord.

Writing Error/Output Error/Communication Error

Check1  If the POWER lamp is off, make sure that the power plug is plugged in, then
turn the printer on.

While the POWER lamp is flashing, the printer is initializing. Wait until the POWER lamp stops flashing and
remains lit.

Check2  Make sure that the printer port is configured appropriately in the printer driver.

* In the following instructions, "XXX" signifies your printer's name.

1. Log on as a user account with administrator privilege.

2. Select items as shown below.

• In Windows 8, select Control Panel from the Settings charm on Desktop > Hardware and Sound
> Devices and Printers.

• In Windows 7, select Devices and Printers from the Start menu.

• In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

• In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open the properties of printer driver for the printer.

• In Windows 8 or Windows 7, right-click the "Canon XXX" icon (where "XXX" is your printer's name),
then select Printer properties.

• In Windows Vista or Windows XP, right-click the "Canon XXX" icon (where "XXX" is your printer's
name), then select Properties.

4. Click the Ports tab to confirm the port settings.
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Make sure that a port named "USBnnn" (where "n" is a number) with "Canon XXX" appearing in the
Printer column is selected for Print to the following port(s).

• If the setting is incorrect:

Reinstall the printer driver with the Setup CD-ROM or install it from our website.

• Printing does not start even though the printer is connected to the computer using a USB cable and
the port named "USBnnn" is selected:

In Windows 8, select My Printer on the Start screen to start My Printer. If My Printer is not
displayed on the Start screen, select the Search charm, then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to
set the correct printer port, then select your printer's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, Canon My Printer, Canon My Printer, then select Diagnose and Repair Printer. Follow
the on-screen instructions to set the correct printer port, then select your printer's name.

If the problem is not resolved, reinstall the printer driver with the Setup CD-ROM or install it from our
website.

Check3  Make sure that the USB cable is securely plugged in to the printer and the
computer.

When the printer is connected to your computer with a USB cable, check the followings:

• If you are using a relay device such as a USB hub, disconnect it, connect the printer directly to the
computer, and try printing again. If printing starts normally, there is a problem with the relay device.
Consult the reseller of the relay device for details.

• There could also be a problem with the USB cable. Replace the USB cable and try printing again.

Check4  Make sure that the printer driver is installed correctly.

Uninstall the printer driver following the procedure described in Deleting the Unnecessary Printer Driver, then
reinstall the printer driver with the Setup CD-ROM or reinstall it from our website.

Check5  Check the status of the device on your computer.

Follow the procedure below to check the status of the device.

1. Open the Device Manager on your computer as shown below.

If the User Account Control screen is displayed, follow the on-screen instructions.

• In Windows 8, select Control Panel from the Settings charm on Desktop > Hardware and Sound
> Device Manager.

• In Windows 7 or Windows Vista, click Control Panel, Hardware and Sound, then Device Manager.

• In Windows XP, click Control Panel, Performance and Maintenance, System, then click Device
Manager on the Hardware sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.

If the USB Printing Support Properties screen is not displayed, make sure that the printer is correctly
connected to the computer.

Make sure that the USB cable is securely plugged in to the printer and the computer.

3. Click the General tab and make sure that there is no indication of a problem with the device.

If a device error is displayed, refer to Windows help to resolve the error.
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Other Error Messages

Check  If an error message is displayed outside the printer status monitor, check the
following:

• "Could not spool successfully due to insufficient disk space"

Delete any unnecessary files to increase the amount of free space on the disk.

• "Could not spool successfully due to insufficient memory"

Quit other running application softwares to increase available memory.

If you cannot print yet, restart your computer and retry printing.

• "Printer driver could not be found"

Uninstall the printer driver following the procedure described in Deleting the Unnecessary Printer Driver,
then reinstall the printer driver with the Setup CD-ROM or reinstall it from our website.

• "Could not print Application name - File name"

Try printing again once the current job is complete.

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is
Displayed

If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a confirmation screen asking for
permission to send the printer and application software usage information will be displayed every month
for about ten years.

Read the instructions on the screen and follow the procedure below.

• If you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent via the
Internet. If you have followed the on-screen instructions, the information will be sent automatically
from the second time onward and the confirmation screen will not be displayed again.
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Note
• When the information is being sent, a caution screen such as an Internet security screen may be

displayed. In this case, confirm that the program name is "IJPLMUI.exe", then allow it.

• If you deselect the Send automatically from the next time check box, the information will not
be sent automatically from the second time onward and a confirmation screen will be displayed at
the time of the next survey. To send the information automatically, see Changing the confirmation
screen setting:.

• If you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is skipped.
The confirmation screen will be displayed again one month later.

• To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall, then follow the
on-screen instructions.

• Changing the confirmation screen setting:

1. Select items as shown below.

◦ In Windows 8, select Control Panel from the Settings charm on Desktop > Programs >
Programs and Features.

◦ In Windows 7, or Windows Vista, select the Start menu > Control Panel > Programs >
Programs and Features.

◦ In Windows XP, select the Start menu > Control Panel > Add or Remove Programs.

Note
• In Windows 8, Windows 7 or Windows Vista, a confirmation/warning dialog box may

appear when installing, uninstalling or starting up software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, follow the on-screen instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.

3. Select Change.

If you select Yes after you have followed the on-screen instructions, the confirmation screen will
be displayed at the time of the next survey.

If you select No, the information will be sent automatically.

Note
• If you select Uninstall (or Remove in Windows XP), the Inkjet Printer/Scanner/Fax

Extended Survey Program is uninstalled. Follow the on-screen instructions.
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If You Cannot Resolve the Problem

If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of
the printer or the service center.

Canon support staff are trained to be able to provide technical support to satisfy customers.

Caution
• If the printer emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power cord

from the outlet and contact the seller or the service center. Never attempt to repair or disassemble the
printer yourself.

• Attempts by customers to repair or take apart the printer will invalidate any warranty regardless of
whether the warranty has expired.

Before contacting the service center, confirm the following:

• Product name:

* Your printer's name is located on the front cover of the setup manual.

• Serial number: please refer to the setup manual

• Details of the problem

• What you tried to solve the problem, and what happened
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Support Code List

The support code appears on the computer screen when an error occurs.

"Support Code" means the error number and appears with an error message.

When an error occurs, check the support code displayed on the computer screen and take the appropriate
action.

Support Code Appears on the Computer Screen

• 1000 to 1ZZZ

1000 1200 1203 1300 1401 1403

1485 1682 1684 1686 1687 1688

1700 1701 1890    

• 4000 to 4ZZZ

4100 4102     

• 5000 to 5ZZZ

5100 5200 5400 5B00 5B01  

• 6000 to 6ZZZ

6000 6800 6801 6930 6931 6932

6933 6940 6941 6942 6943 6944

6945 6946     

• A000 to ZZZZ

B200 B201     

About the support code for paper jam, you can also refer to Support Code List (When Paper Is Jammed).
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Support Code List (When Paper Is Jammed)

If the paper is jammed, remove it following the procedure appropriate for each case.

• If you can see the jammed paper at the paper output slot or the rear tray:

1300

• If the paper tears and you cannot remove it from the paper output slot or from the rear tray:

Paper Is Jammed inside the Printer

• Cases other than above:

In Other Cases
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1300

Cause

Paper is jammed in the paper output slot or in the rear tray.

Action

Remove the jammed paper following the procedure below.

Important
• When the paper jam error has occurred, you cannot turn the printer off the even if you press the ON/

RESUME button on the printer. Take the appropriate action of the paper jam error, then turn the
printer off.

1. Pull the paper out slowly, either from the rear tray or from the paper output slot,
whichever is easier.

Hold the paper with your hands, then pull the paper out slowly not to tear it.

Note
• If the paper tears and you cannot remove the jammed paper from the paper output slot or the

rear tray, remove the paper from inside the printer.

Paper Is Jammed inside the Printer

2. Reload the paper, and press the ON/RESUME button on the printer.

The printer resumes printing.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are

loading it correctly.

• We recommend you use paper other than A5 sized one to print documents with photos or
graphics; otherwise, the printout may curl and cause paper exit jams.
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If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues
after removing the paper, contact the service center.
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Paper Is Jammed inside the Printer

If the jammed paper tears and you cannot remove the paper either from the paper output slot or from the
rear tray, or if the jammed paper remains inside the printer, remove the paper following the procedure
below.

Important
• When the paper jam error has occurred, you cannot turn the printer off the even if you press the ON/

RESUME button on the printer. Take the appropriate action of the paper jam error, then turn the printer
off.

1. Retract the paper output tray, then open the cover.

Important
• Do not touch the clear film (A).

If the paper or your hands touch the clear film and blot or scratch it, the printer can be damaged.

2. Make sure that the jammed paper is not under the FINE cartridge holder.

If the jammed paper is under the FINE cartridge holder, move the FINE cartridge holder to the right edge
or the left edge whichever is easier to remove the paper.

When you move the FINE cartridge holder, hold the FINE cartridge holder and slide it slowly to the right
edge or the left edge.
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3. Hold the jammed paper with your hands.

If the paper is rolled up, pull it out.

4. Pull the paper slowly not to tear it, then pull the paper out.

5. Make sure that all the jammed paper is removed.

If the paper is torn, a piece of paper may remain inside the printer. Check the following and remove the
piece of paper if it remains.

• Does the piece of paper remain under the FINE cartridge holder?

• Does the little piece of paper remain inside the printer?
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• Does the piece of paper remain in the right side or the left side space (B) inside the printer?

6. Close the cover.

7. Reload the paper, and press the ON/RESUME button on the printer.

The printer resumes printing.

Note
• When reloading the paper, confirm that you are using the paper suited for printing and are loading

it correctly. If the message about paper jam is displayed on the computer screen when you
resume printing after removing all the jammed paper, a piece of paper may remain inside the
printer. In this case, confirm that no piece of paper remains inside the printer.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error continues after
removing the paper, contact the service center.
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In Other Cases

Make sure of the following:

Check1  Are there any foreign objects around the paper output slot?

Check2  Are there any foreign objects in the rear tray?

If there are any foreign objects in the rear tray, be sure to turn off the printer, unplug it from the power supply,
then remove the foreign object.

Check3  Is the paper curled?

Load the paper after correcting its curl.
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1000

Cause

There is no paper in the rear tray.

Action

Load paper in the rear tray and press the printer's ON/RESUME button.

Important
• When the paper out error has occurred, you cannot turn the printer off the even if you press the ON/

RESUME button on the printer. Before turning the printer off, take the following actions.

• Load paper to resume printing.

• Cancel printing on the message screen displayed on your computer.
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1200

Cause

The cover is open.

Action

Close the cover and wait for a while.
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1203

Cause

The cover is opened while printing is in progress.

Action

If paper is left inside the printer, remove the paper slowly with both hands and close the cover.

Press the printer's ON/RESUME button to dismiss the error.

The printer ejects one blank sheet of paper and resumes printing from the next paper.

The printer will not reprint the page that was printed when the cover is opened. Try printing again.

Important
• Do not open or close the cover while printing is in progress, as this can damage the printer.
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1401

Cause

The FINE cartridge is not installed.

Action

Install the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1403

Cause

The FINE cartridge cannot be recognized.

Action

Replace the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1485

Cause

Appropriate ink cartridge is not installed.

Action

Printing cannot be executed because the ink cartridge is not compatible with this printer.

Install the appropriate ink cartridge.

If you want to cancel printing, press the printer's ON/RESUME button.
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1682

Cause

The FINE cartridge cannot be recognized.

Action

Replace the FINE cartridge.

If the error is not resolved, the FINE cartridge may be damaged. Contact the service center.
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1684

Cause

The ink cartridge cannot be recognized.

Action

Printing cannot be executed because the ink cartridge may not be installed properly or may not be
compatible with this printer.

Install the appropriate ink cartridge.

If you want to cancel printing, press the printer's ON/RESUME button.
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1686

Cause

The ink may have run out.

Action

The function for detecting the remaining ink level will be disabled since the ink level cannot be correctly
detected.

If you want to continue printing without this function, press the printer's ON/RESUME button for at least 5
seconds.

Canon recommends to use new genuine Canon cartridges in order to obtain optimum qualities.

Please be advised that Canon shall not be liable for any malfunction or trouble caused by continuation of
printing under the ink out condition.
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1687

Cause

The FINE cartridge is not installed properly.

Action

Retract the output tray extension and the paper output tray, open the cover, then remove the FINE
cartridges.

Then install the FINE cartridges again. Push the FINE cartridge until it clicks into place.

After installing, close the cover.
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1688

Cause

The ink has run out.

Action

Replace the ink cartridge and close the cover.

If printing is in progress and you want to continue printing, press the printer's ON/RESUME button for at
least 5 seconds with the ink cartridge installed. Then printing can continue under the ink out condition.

The function for detecting the remaining ink level will be disabled.

Replace the empty ink cartridge immediately after the printing. The resulting print quality is not
satisfactory, if printing is continued under the ink out condition.
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1700

Cause

The ink absorber is almost full.

Action

Press the printer's ON/RESUME button to continue printing. Contact the service center.
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1701

Cause

The ink absorber is almost full.

Action

Press the printer's ON/RESUME button to continue printing. Contact the service center.
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1890

Cause

The protective material for the FINE cartridge holder or the tape may remain attached to the holder.

Action

Make sure that the protective material or the tape does not remain attached to the FINE cartridge holder.

If you find the protective material or the tape remains attached, retract the output tray extension and the
paper output tray to remove the protective material or the tape.

Pull down the tape to remove the protective material.

Close the cover after removing the protective material.

If the problem is not resolved, contact the service center.
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4100

Cause

The specified data cannot be printed.

Action

When you print the contents on CREATIVE PARK PREMIUM, confirm the message on the computer
screen, make sure that genuine Canon FINE cartridges are all installed properly, then start printing again.
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4102

Cause

The media type and paper size are not set correctly.

Action

Press the printer's ON/RESUME button to cancel printing, change the media type or paper size setting,
then print again.

• When the media type is set to Photo Paper Plus Glossy II:

Set the paper size to 4"x6" 10x15cm (Windows)/4 x 6 (Mac), or 5"x7" 13x18cm (Windows)/5 x 7
(Mac).

• When the media type is set to Glossy Photo Paper:

Set the paper size to 4"x6" 10x15cm (Windows)/4 x 6 (Mac).

• When the media type is set to Envelope:

Set the paper size to Envelope Com 10 (Windows)/Envelope #10 (Mac) or Envelope DL (Windows/
Mac).
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5100

Cause

Printer error has occurred.

Action

Cancel printing, turn off the printer. Then clear the jammed paper or protective material that is preventing
the FINE cartridge holder from moving, and turn on the printer again.

If the problem is not resolved, contact the service center.

Important
• When you clear the jammed paper or protective material that is preventing the FINE cartridge holder

from moving, be careful not to touch the components inside the printer. The printer may not print out
properly if you touch it.
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5200

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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5400

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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5B00

Cause

Printer error has occurred.

Action

Contact the service center.
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5B01

Cause

Printer error has occurred.

Action

Contact the service center.
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6000

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6800

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6801

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6930

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6931

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6932

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6933

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.

317



6940

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6941

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6942

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6943

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6944

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6945

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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6946

Cause

Printer error has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Plug the printer back in and turn the printer back on.

If the problem is not resolved, contact the service center.
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B200

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Contact the service center.
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B201

Cause

An error requiring you to contact the service center has occurred.

Action

Turn off the printer, and unplug the power cord of the printer from the power supply.

Contact the service center.
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